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a Composed Scene
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 Photography, 
 Branding & Design
Branding and design for a photography business goes way beyond 
just creating nice-looking logos, websites, and marketing collat-
eral. A photographer really needs to understand who he or she 
is and his or her style of photography. You also need to decide 
if you’re going to go it alone or employ the services of a profes-
sional designer. Paul Hebron sat down with designer Meg Long 
and photographers Pam Conchas and Tara Nalani to discuss all of 
these topics and more.
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It’s a brand-new year, and there’s so much cool stuff to share, but I want to start with some pretty big news. We’re excited to 
announce that for the first time ever we’re combining our East and West Coast Photoshop World Conferences into one mega show 
this August 10–13, 2015, in Las Vegas. (Don’t worry—we’re not going to call it Mega Photoshop World, but I have to admit, the 
thought did cross my mind.) 

This is a first for us on so many levels. It’s the first time we’ve been able to hold the conference in August, which will enable many 
more educators to attend the conference who normally miss out because school is already in session. It also allows us to offer more 
training than ever with more instructors and to expand our video training, making the best conference of its kind even bigger and 
better. Lastly, it lets us focus our energy on one show per year, rather than splitting our efforts, and audience, between the two 
coasts, allowing us much more time to focus on providing the best way to learn Photoshop, photography, Lightroom, and design 
all year long.

What else does this year have in store? A lot more full-length online training courses are already in the works. We now have more 
than 500 in-depth, full-length classes, and our library of classes keeps growing every week. By the way, Thursday is new class day at 
KelbyOne, and we release anywhere between one to three new classes created exclusively for KelbyOne members.

How about here in the mag? We’re adding more Lightroom tutorials and training, more on the Creative Cloud apps, and of 
course, loads and loads of Photoshop (but you knew that part, right?). With Adobe releasing new features to Creative Cloud users 
(there are well more than three million Creative Cloud subscribers and growing), it keeps us jumping staying on top of it all, but hey, 
we’re not complaining—that’s our job (plus, it’s nice not having to wait 18 months for new features). Of course, we’ll still have loads 
of tutorials for users of CS6, as well, so don’t worry, we have everybody covered in 2015.

To kick off the new year, we launched the KelbyOne Blog, and with it, we brought Julio Aguilar onboard as a new team member 
to host it. Julio will be joining RC Concepcion, Pete Collins, Corey Barker, and me in creating an absolutely kick-butt blog, packed 
with tutorials, news, reviews, and everything cool in Photoshop, Lightroom, photography, and design (are you picking up on a theme 
here?). Julio is an awesome guy, and we think you’re totally going to dig hearing from him every day on the blog. If you haven’t 
checked it out yet, head over to kelbyone.com/blog.

In this issue, there’s a lot of awesome stuff. Our cover story is from Paul Hebron and it’s called “Photography, Branding, and 
Design.” It has some great advice on when photographers should try to create their own branding and when it’s time to hire a 
designer. But no matter which path you choose, this article offers some great tips on things you should think about when creating 
your brand.

One of my favorites this issue is Scott Valentine’s article on one of the hottest portrait-retouching techniques for working with skin: 
frequency separation. Scott teaches you how to identify the frequencies in your images to make this technique even more effective. It 
will change how you retouch skin from here on out. In our “Dynamic Range” column, Uli Staiger shows us “How to Create Shadows 
in Composed Scenes” (shadows are key to making composites look realistic). There’s a bunch more, from our “Beginners’ Workshop” 
column to Lightroom to lighting, and it’s all right here, so turn the page and get right to it.

We’re going to have a kick-butt 2015, and I’m very grateful you’re here with us on this educational journey. We have lots of 
exciting new courses, tutorials, articles, news, reviews, a brand-new blog, new ways to learn, and a mega conference in Vegas, and 
we want you to be a part of every bit of it as we inform, inspire, connect, and take the creative world by storm. The year 2015 is 
going to rock! 

All my best, 

Scott Kelby
KelbyOne President & CEO
Editor & Publisher, Photoshop User

From the Editor
 welcome to super  
 photoshop world

A  F E W  W O R D S  F R O M  ›  ›  S C O T T  K E L B Y

kelbyone.com/blog
http://www.epson.com/cgi-bin/Store/jsp/Landing/finish-strong_ad.do?ref=van_ad_fsmain
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STEVE BACZEWSKI 
is a freelance writer, professional photographer, graphic designer, and  

con sultant. He also teaches classes in traditional and digital fine arts photography.  
His company, Sore Tooth Productions, is based in Albany, California. 

 PETER BAUER 
is an Adobe Certified Expert that does computer graphics consulting for a select  

group of corporate clients. His latest book is Photoshop CC for Dummies. He was 
inducted into the Photoshop Hall of Fame in 2010.

TOM BOL 
is an editorial and commercial photographer specializing in adventure sports, por-

traits, and outdoor lifestyle photography. His images and stories are used worldwide. 
You can see more of his work at www.tombolphoto.com.

PETE COLLINS 
is an education and curriculum developer and website overseer for KelbyOne. He is one 
of the Photoshop Guys and co-hosts Photoshop User TV. With a fine arts background, 

Pete is well versed in photography, graphic design, and illustration.

MICHAEL CORSENTINO 
is an award-winning wedding and portrait photographer, Photoshop and Lightroom 

expert, author, columnist for Shutter Magazine and Resource Magazine, and speaker and 
international workshop leader. Learn more at www.michaelcorsentino.com. 

SEÁN DUGGAN 
is the co-author of Photoshop Masking & Compositing, Real World Digital 

Photography, and The Creative Digital Darkroom. He leads workshops on digital 
photography, Photoshop, and Lightroom (SeanDuggan.com).

DANIEL EAST 
is an author, free lance writer, presenter/trainer, and consultant with more than 20 years’ 

experience in photography, pro-audio, and marketing. Daniel is also founder and president 
of The Apple Groups Team support network for user groups.

PAUL HEBRON 
is a freelance consultant in the Seattle area. He has worked as a graphic designer,  

an art director, and a creative director. For more information about Paul, visit  
http://about.me/paulhebron.

SCOTT ONSTOTT 
is the creator of Photoshop for Architects: CC Edition and author of Enhancing Arch­
itectural Drawings and Models with Photoshop, Taking Measure (secretsin plainsight 
.com), and other books and videos. See what he’s up to at ScottOnstott.com. 

COLIN SMITH 
is an award-winning digital artist, photographer, and lecturer who has authored  
18 books and has created a series of training videos. Colin is also the founder of  
the online resource PhotoshopCAFE.com and president of Software-Cinema.com.

LESA SNIDER 
is the author of Photoshop CC: The Missing Manual, several eBooks, and video  
courses, as well as co-author of iPhoto: The Missing Manual. She’s also a columnist for 
Macworld and Photographic Elements Techniques. For more info, visit PhotoLesa.com.

ULI STAIGER 
started out as a photographer in 1990. After traveling through Europe and the Ameri-
cas, he opened his own studio in Berlin, Germany. Since 2004, Uli has worked as a 
Photoshop artist, author, and trainer. For more, visit www.dielichtgestalten.de.

ROB SYLVAN 
is the Lightroom Help Desk Specialist for KelbyOne, on staff at the Digital Photo  
Workshops, and the author of Lightroom 5: Streamlining Your Digital Photography 
Process. You can learn more at www.lightroomers.com.

SCOTT VALENTINE 
is an Adobe Community Professional and Photoshop author. His latest book  
is The Hidden Power of Adjustment Layers (Adobe Press). Keep up with him  
at scoxel.com.

ERIK VLIETINCK 
founded IT Enquirer in 1999 (http://it-enquirer.com). A J.D. by education, Erik  
has been a freelance technology editor for more than 20 years. He has written  
for Macworld, Computer Arts, Windows NT Magazine, and many others. 

JAKE WIDMAN 
is a writer and editor who lives in San Francisco. He’s been covering the intersection  
of computers and graphic design for about 25 years now—since back when it was 
called “desktop publishing” and Photoshop was just a piece of scanning software.
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Photoshop User 
Magazine
Photoshop User magazine is the official publication of 
KelbyOne. As a KelbyOne member, you automatically 
receive Photoshop User delivered right to your door (or 
digitally) ten times a year. Each issue features in-depth 
Photoshop, Lightroom, and photography tutorials writ-
ten by the most talented designers, photographers, and 
leading authors in the industry.

KELBYONE 
is the world’s leading resource for Adobe® Photoshop®, Lightroom®, and 

photography training, news, and education. Founded in 1998 as the National 
Association of Photoshop Professionals (NAPP), KelbyOne has evolved from 

NAPP and KelbyTraining to create a singular hub for creative people to learn, grow, 
and inspire. From photographers to graphic designers, beginners to professionals, 

KelbyOne is open to everyone.    

There’s no faster, easier, and more affordable way to get really good at Photoshop 
and photography. You can join for only $25 per month or $249 U.S. for a full year 

of training. To learn more, visit www.kelbyone.com.

 

 

PHOTOSHOP USER MAGAZINE 
Ten issues of the best Photoshop tutorial-based magazine in the industry.  

MEMBERS-ONLY WEBSITE 
Our extensive website features time- and money-saving content.

ONLINE CLASSES & EDUCATION 
Thousands of Photoshop and photography tutorials, full online classes,  

and quick-tip videos. 

MEMBER DISCOUNTS 
Save anywhere from 2–4 times your membership cost by using our many 
industry-related discounts.

TECH SUPPORT 
Fast, friendly Photoshop, Lightroom, and photo gear help; equipment 
advice; and more from certified experts.

MEMBER COMMUNITY 
KelbyOne members range from beginners to pros and love to lend each 
other a hand. Together, we have built the friendliest, most knowledgeable 
Photoshop and photography community on the Web.

NEWS & REVIEWS 
Unbiased coverage on the latest equipment, plug-ins, and programs 
in the marketplace.

WEEKLY E-NEWSLETTER 
The KelbyOne Insider is your weekly connection to everything KelbyOne.  
It’s produced exclusively for members to keep you informed of everything 
new in the industry and at KelbyOne headquarters.

REGISTRATION DISCOUNT 
TO PHOTOSHOP WORLD 
CONFERENCE & EXPO 
The annual KelbyOne convention and the largest Photoshop and  
photography learning experience on the planet. It’s an amazing event.

FIND KELBYONE MEMBERSHIP DETAILS AT kelbyone.com or call 800-738-8513 Monday–Friday, 9:00 a.m. to 5:30 p.m. EST.

About KelbyOne

Member Benefits

www.kelbyone.com
kelbyone.com
http://www.manfrotto.us
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›  › Inspiration, information, and member musings to fuel your creative think tank
BY HEATHER SHORTT

KelbyOne Community

The KelbyOne Blog:    
a new source of inspiration 
It’s time to bookmark your new favorite blog—the KelbyOne blog at kelbyone.com/

blog. While it may have launched a few months ago, the content we’re serving up is 

fresh, hot, and winning a lot of cool points among our community.

What will we be blogging about in 2015? Really, really, ridiculously awesome stuff to 

keep you inspired, motivated, and informed. We vow to make sure you’re in the know 

about all things photography, Photoshop, Lightroom, design, and video. Our content 

gurus are people in the biz. They know what growing creatives want to hear and learn 

about. You can expect straight-shooting commentary on industry trends and what’s 

happening in today’s world of photography and design. This covers news, technology 

updates, and hot, trending topics. As always, we’ll keep you informed about all things 

KelbyOne, including behind-the-scenes sneak peeks at upcoming classes, instructor 

news, and quick-and-dirty tips you can immediately apply to everyday projects.

And while we love spoon-feeding you the latest and greatest material in this big, bold, creative world we like to dwell in, the blog is 

the perfect spot for us to hear from you. Be sure to comment and share your two cents on the stories and posts that strike your fancy. 

What would be even better is submitting your ideas on what you want to see. Just drop us a line at kelbyone.com/blog/submit-idea. 

You may be the inspiration for our next post.

DSLR Filmmaking: Video Basics

Learn the basics with Mia McCormick 

as she breaks down the simple steps 

and settings to getting started with 

your DSLR video feature.

DSLR Filmmaking: Camera Motion & Support

When you’re ready for the next level, 

jump into Adam Rohrmann’s DSLR 

Filmmaking: Camera Motion & Sup-

port, where he’ll take you through 

the technical how-to aspects of six of 

the most common camera supports 

used in DSLR filmmaking.

DSLR Filmmaking: 25 Tips in Premiere Pro

When you’re ready to make your edit-

ing workflow smoother, faster, and 

more efficient, jump into 25 Tips in Pre-

miere Pro with Brandon Ford. He covers 

all the little tricks of the trade for effec-

tive editing. 

This is just a quick start into the world of DSLR filmmaking. 

Be sure to add it to your things to try in 2015. We’ll be 

dropping more classes on this topic, but you can find the 

above titles and so much more under the Video category at 

Kelbyone.com. 

Filmmaking    
made easy
One hot topic you’ll be seeing a lot from us this year is DSLR 

filmmaking. Over the past few years, shooting high-defini-

tion video with your DSLR has been relatively popular. It even 

became the fast choice for indie cinematographers around 

the world. But budding photographers and even profession-

als focused primarily on specific niches may be overlooking 

this fun, fast-growing feature on their DSLR.

At KelbyOne, we have our very own experts who can 

help you tap into this bonus feature, and who knows, 

maybe you’ll be the next big indie filmmaker. This isn’t 

so far fetched considering with the right training (ahem, 

KelbyOne) you can start bringing a new stream of income 

into your photography business. This year is the perfect time 

to start learning from working professionals like Brandon 

Ford and Adam Rohrmann on how to leverage the video 

feature on your DSLR.

Soon we’ll be rolling out fresh new training on lighting, 

editing, and audio for video. But for now, we have a whole 

batch of content that can help you get started with film-

making. Here’s a quick list on where you should head first 

to kick off your DSLR filmmaking cram sessions. 

Using the Video Feature in Your New DSLR

Brandon Ford recently answered the top five questions pho-

tographers have about using the DSLR feature on their cam-

era. Check out these quick tips over at kelbyone.com/blog/

using-video-feature-new-dslr.

ARTIST SPOTLIGHT ›  ›  ELAINE ERSKINE 
MEMBER SINCE 2014 | WWW.FACEBOOK.COM/PAGES/THE-WAY-I-SEE-IT/211362638879282   

ARTIST SPOTLIGHT ›  ›  RORY HOLMES 
MEMBER SINCE 2014 

ARTIST SPOTLIGHT ›  ›  COLLEEN CROWLEY 
MEMBER SINCE 2000 | WEDDING CLIENT
HTTP://COLLEEN-CROWLEY-PHOTOS.SMUGMUG.COM

ARTIST SPOTLIGHT ›  ›  SCOTT ENGEL  
MEMBER SINCE 2007 | EBOOK: ANIMAL PHOTO SAFARI 
WWW.ENGELIMAGES.COM

kelbyone.com/blog
kelbyone.com/blog
kelbyone.com/blog/submit
Kelbyone.com
kelbyone.com/blog/using
kelbyone.com/blog/using
www.facebook.com/pages/The
http://colleen-crowley-photos.smugmug.com
www.engelimages.com
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You’re in a time machine and photographing a past, 

present, or future event is possible. What is it? 

The Birth of Christ, the Crucifixion, or the Resurrection—

one of those three.

It’s time for some shameless bragging. Tell us about 

some cool things you’ve been honored to be a part of. 

I have been invited to speak on panels at Comic Con (next 

year, too) and have worked with some of the best photog-

raphers in the world, including National Geographic pho-

tographer, Michael Nolan. I work with film studios here in 

L.A. on various projects and now will be creating a unique 

line of animal-themed artworks with Michael Nolan.

Final question just for kicks: What would your 

superpower be? 

I know I always wished I could fly! But is that really 

a superpower?

We think your creativity and successes are flying pretty high, 

Claudia. Keep soaring. We’ll be watching. Check out more 

of Claudia’s work at http://phatpuppyart.com.

Who's Who 
 in the kelbyone community

Meet Claudia McKinney. This five-year KelbyOne alum has 

been making a successful mark as a digital artist focused on 

best-selling book covers. She caught the eye of Pete Collins 

as a recent Image of the Week pick at http://members 

.photoshopuser.com with her depiction of childlike won-

der in Maria’s Angel. Take a look inside the magical world  

of Claudia.

Tell us about Maria’s Angel. Was it work or play? 

I must admit that 99% of my work is fun—even when it’s 

for work. Occasionally, I will have one of those odd pieces 

where it’s like pulling hair, but those are a rarity for me. 

This image was done for a very dear friend and author, 

Maria Hooley. This is her beautiful daughter. The minute 

she showed me the raw image, I knew I wanted an angel 

made. So this piece was a total labor of love.

What keeps you inspired in your work? 

I have family who have lived through incredible hardships, 

and they are really what inspire me the most in my day-to-

day work—a constant reminder and inspiration of what is 

possible in my life.

How has KelbyOne helped in your creative journey?

KelbyOne is full of great people and teachers. It’s a feeling 

of community, a nice place to visit and share. 

What’s one of the most helpful lessons you’ve learned? 

Stay true to yourself. There are so many people who copy 

ideas and concepts. It’s one thing to be inspired by another 

artist; it’s another to steal. So I guess the most important 

thing is to create art that flows from the deepest part of 

you. The rest will fall into place as you learn and grow as 

an artist.

If you could pick anyone (living or dead) to be your 

mentor, who would it be? 

Wow that’s a toughie—so many people! If you had to 

say just for art alone, Michelangelo, William-Adolphe 

Bouguereau, or more contemporary, Andrew Wyeth. If 

you were to say for photography—too many to choose. 

If you were to say in life, I would say St. Francis of Assisi. 

His love for the Creator, nature, beauty in general—and 

most of all, joyful simplicity in everything—motivates me 

every day I sit down to work. If we’re talking music, that’s 

easy: Vivaldi. John Denver, too. His music has inspired 

me since I was two. Many of my artwork is named after 

his songs. 

ARTIST SPOTLIGHT ›  ›  JASON B. WHITMAN 
MEMBER SINCE 2014 | WWW.JASONWHITMANPHOTO.COM

ARTIST SPOTLIGHT ›  ›  JOHN GELDERMANN 
MEMBER SINCE 2013 | HTTP://VOLLEYSHOTS.SMUGMUG.COM

http://phatpuppyart.com
photoshopuser.com
www.jasonwhitmanphoto.com
http://volleyshots.smugmug.com
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“@aboutrc Your Photomatix lesson on  
@kelbyone esp the HDR panoramic bit just 
answered soooo many questions! Thank 
you! #learningisgreat”—@rmtempler

“@martinwacephoto Thanks Martin. Do 
you use @kelbyone or perhaps intend to in 
the future? It’s fantastic and recommended 
fully by me!”—@PhotoshopPro

“Finally got around to watch @miamac‘s 
Trailblazer interview with @StacyPearsall 
over on @kelbyone #blewmymind 
#mesmerized”—@MBaeckman

Spread the 
 good word

Teaching is our passion. It’s in everything we do. And hearing your 

success validates the very reason why we’re here. So preach on about 

the good word. We’re all ears. 

“Happy New Year! I am looking forward to more learning with 

you during the course of the new year!”—Arthur B.

“I’ve been a member for a week or two now. In such a short time 

I have learned sooooooo much more about 2 programs I’ve had 

for years. Thank you all.”—Alan P.

“I love street photography, not something I get to do that often. 

However, Jay Maisel, albeit controversial at times, might be one 

of my favorite photographers at all time. If you have a KelbyOne 

subscription this series is worth watching.”—John M. 

“Just watched The Grid and am hooked, it was so inspiring. Thank 

you.”—Aurora J.

“KelbyOne is my source for learning LR and PS.”—Armando L. ■

ARTIST SPOTLIGHT ›  ›  KERRIN BURKE LAHR 
MEMBER SINCE 2012 | WWW.KERRINBURKELAHR.COM 
 

www.kerrinburkelahr.com
http://www.portraitprofessional.com
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BY MIKE MACKENZIE AND CHRIS MAIN

 ›  ›  e x p o s e d :  i n d u st r y  n e w s

Canon Announces 
five new powershot cameras
Canon (www.usa.canon.com) has been busy fortifying its line of PowerShot 

compact cameras, announcing that five new models will be available in February. 

The PowerShot SX530 HS has a 50x optical zoom lens (equivalent to 24–1200mm) 

with Optical Image Stabilization, making it a great choice for photographing wild-

life and adventures. It combines a 16-megapixel CMOS sensor and DIGIC 4+ Image 

Processor, allowing for excellent low-light performance. The SX530 HS includes 

Canon’s Zoom Framing Assist feature that intelligently controls the lens, making it 

easy to identify the subject, even when it’s in motion. It also captures 1080p Full 

HD video and is Wi-Fi and NFC capable. The PowerShot SX530 HS costs $429.99.

Next up is the PowerShot SX710 HS with a 30x optical zoom lens (25–750mm equivalent), Intelligent IS, 20.3-megapixel CMOS 

sensor, and DIGIC 6 Image Processor. The SX710 HS also includes Zoom Framing Assist, 1080p Full HD video at up to 60 frames per 

second, and Creative Shot and Short Clip modes for artistic and creative photos and videos. An interesting feature is Story Highlights 

mode, where the camera creates a highlight reel of selected images to create a unique imaging experience. Photographers can then 

share their photos via built-in Wi-Fi. The PowerShot SX710 HS goes for $349.99.

The PowerShot SX610 HS is a 20.2-megapixel compact camera with a DIGIC 4+ Image Processor, 18x optical zoom lens (equiva-

lent to 25–450mm), and Wi-Fi and NFC connectivity. It’s available in red, white, or black and costs $249.99.

Rounding out the new releases is a pair of PowerShot ELPH cameras: the ELPH 170 IS and ELPH 160. The ELPH 170 IS has a 

12x optical zoom lens (25–300mm equivalent), 20-megapixel CCD sensor, Intelligent IS, 720p HD video capture, a Smart AUTO 

mode that chooses optimal settings for photos, and creative effects, such as Toy Camera and Monochrome. It comes in blue, 

silver, or black and costs $149.99.

The ELPH 160 has an 8x optical zoom lens (28–224mm equivalent), 20-megapixel CCD sensor, and 720p HD video capture. It’s 

available in black, white, silver, or red for $119.99. 

Adobe to   
 acquire fotolia

Recently, Adobe announced that it entered into an agreement to acquire Fotolia, a leading provider of royalty-free photos, images, 

graphics, and HD videos. Adobe will integrate Fotolia into the Adobe Creative Cloud, providing current and future Creative Cloud 

members with the ability to access and purchase images and videos for their projects. The move bolsters Creative Cloud’s mar-

ketplace for creatives to buy and sell assets, as well as showcase their talent to a global audience. Adobe also plans to continue 

operating Fotolia as a standalone stock service that’s accessible to anyone.

The transaction is expected to close in the second half of Adobe’s fiscal first quarter 2015. Until the closing, both companies 

will continue to operate independently. After closing, Fotolia CEO Oleg Tscheltzoff will continue to lead the Fotolia team as part of 

Adobe’s Digital Media business. For further details about the acquisition, visit www.adobe.com.

Exp  sed: Industry News
The latest news about photography gear, software, and services›  ›

Adorama Unveils New Flashpoint Zoom Li-on On-Camera  
flashes and accessories
As we were going to press, Adorama (www.adorama.com) announced the immediate availability of Flashpoint Zoom Li-on Flashes 

and Commander Transmitter and Receiver Set. The Zoom Li-on Flash is a hot-shoe flash available in Manual, Canon TTL, and Nikon 

TTL models. It runs off an internal lithium-ion battery, giving it the benefits of an external battery pack without the cables. It has 

a recycle time of 1.5 seconds, and it can fire up to 350 full-power shots on a battery charge. The flash head rotates 360° and tilts 

more than 90°, and it has a zoom range from 24–105mm. 

The TTL models offer the extra features of proprietary TTL flash units, such as high-speed sync (HSS) up to 1/8000, exposure 

compensation, exposure bracketing, automatic zoom, and exposure lock. They’re integrated with proprietary TTL strobe IR remote 

systems, and can be used as a master, slave, or in groups. 

The Zoom Li-on Flash comes with a lithium-ion battery pack, charger, mini stand, case, and instruction manual. The Manual flash 

costs $99.95, and the Canon TTL and Nikon TTL models go for $179.95.

Accompanying the Zoom Li-on Flash is the new Zoom Li-on Flash Commander Transmitter and Receiver Set. The set allows 

for control from 150' away, and you can adjust the flash remotely. It has 16 channels and 16 groups, so you can control 

individual units or groups and not interfere with other photographers. The Command Transmitter and Receiver Set sells  

for $69.95.

Wacom Launches New Flagship  
cintiq and cintiq companion 2
At CES 2015, Wacom announced the new Cintiq 27QHD and Cintiq 27QHD touch, as well as the Cintiq Companion 2. The Cintiq 

27QHD displays 1.07 billion colors and 97% of Adobe’s color gamut with a resolution of 2560x1440. Using different pen nibs, 

including felt nibs, designers, artists, and game developers can work directly onscreen with a natural pen-on-paper feel. The touch 

version allows users to manipulate images onscreen with their fingers on one hand while sculpting or sketching with the pen in 

their other hand.

The Cintiqs also come with the new ExpressKey Remote. The remote, which can be placed onscreen or next to the keyboard, 

provides users with a customized set of keyboard shortcuts. The Cintiq 27QHD will retail for $2,299.99 and the touch version will 

be $2,799.99. They will replace the Cintiq 24HD and should be available in late January.

The new Cintiq Companion 2 is a mobile solution that works either as a Windows 8 tablet with all the capabilities of a Cintiq, or 

you can connect it to a Mac or PC and use it as a secondary Cintiq display. Several configurations of the Cintiq Companion 2 will 

be available in February, with prices starting at $1,299.99. For more information on all Cintiq models, visit www.wacom.com. ■

Nikon Announces   
new dslr and two lenses
Nikon kicked off 2015 by announcing the new Nikon D5500 

DSLR and NIKKOR 55–200mm and 300mm lenses. The 

D5500 is a lightweight, DX-format camera with a 24.2-mega-

pixel CMOS sensor. The removal of the optical low-pass  

filter allows for sharp, detailed photos, and the EXPEED 4 

image processing engine gives the D5500 improved speed 

and performance.

Other features of the D5500 include a 3.2" Vari-angle touch 

LCD display; an ISO range from 100–25,600; HD 1080/60p video 

capture with full-time autofocus and stereo sound; a 39-point autofocus system with 9 cross-type sensors; and a durable monocoque 

structure that keeps the camera safe. Photographers also benefit from 16 scene modes, more effects modes, and enhanced picture 

controls. The D5500 also includes built-in Wi-Fi that allows photographers to easily share photos with friends.

The D5500 is available in early February, comes in black or red, and costs $899.95 for the body only, $999.95 with the AF-S DX 

NIKKOR 18–55mm f/3.5–5.6G VR II lens, or $1,199.95 with the AF-S DX NIKKOR 18–140mm f/3.5–5.6G ED VR lens.

On the lens front, Nikon announced the AF-S NIKKOR 55–200mm f/4–5.6G ED VR II zoom lens for DX-format cameras, and 

the FX-format AF-S NIKKOR 300mm f/4E PF ED VR lens. The 55–200mm is a kit lens that’s compact, lightweight, has 3 stops of 

Vibration Reduction stabilization, and a Silent Wave Motor, making it a great choice for photographing school functions, sports, 

and people.

The 300mm f/4 lens is billed as the world’s lightest 300mm, full-frame, fixed focal length, AF lens. It’s nearly 30% shorter and 

1.5 lbs lighter than its predecessor, so it should be easy to handle. The lens uses Phase Fresnel optical technology to help correct 

chromatic aberration. It also features up to 4.5 stops of Vibration Reduction stabilization, VR sport mode, VR tripod detection, 

electromagnetic aperture control, a Silent Wave Motor, ED glass to further control chromatic aberrations, and Nano Crystal Coat 

for superior image quality.

The AF-S DX NIKKOR 55–200mm f/4–5.6G ED VR II and AF-S NIKKOR 300mm f/4E PF ED VR lenses will also be available in 

early February for $349.95 and $1,999.95, respectively. For more information, visit www.nikonusa.com. 

www.usa.canon.com
www.adobe.com
www.adorama.com
www.wacom.com
www.nikonusa.com
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This was part of a request I received a while back from a designer 
who wanted to be able to add splash effects to a photo without 
having to shoot the splashes himself. You’ve probably seen im-
ages floating around with dresses made from splashes and such. 
Well, here’s a quick and easy way to get that look with a few simple 
stock images, and it’s not quite as messy. Enjoy!

splash and color effects
B Y  C O R E Y  B A R K E R

Step One: As usual, we’ll begin with a photo. Here’s a shot of 

a dancer in midair. I like this one because of the position of the 

dancer, but I also like the color of her leggings. We’ll use that as 

a base to color the splashes later. You can download this image, 

along with the other asset files to follow along, or you can use 

your own. 

[KelbyOne members may download the files used in this tuto-

rial at http://kelbyone.com/magazine/issue/february-2015. All 

files are for personal use only.]

Step Two: The first thing we need 

to do is extract the dancer from the 

white background. Since the back-

ground is solid white, extracting her 

should be pretty easy. Remember, 

the simpler the background the bet-

ter. In this case we’ll use a channel 

method to extract. Open the Chan-

nels panel (Window>Channels) and 

Command-click (PC: Ctrl-click) on 

the RGB thumbnail preview. This will load the overall brightness 

of the image as an active selection. Since the background is white 

and the subject is mostly darker, we know that the background is 

100% selected and the subject is partially selected. 

Step Three: Now choose Select>Inverse. This will flip the selec-

tion around, leaving the background unselected and the subject 

mostly selected. With the selection inverted, click the Create New 

Channel icon at the bottom of Channels panel to add a new 

alpha channel. Press Shift-Delete (PC: Shift-Backspace) to open 

the Fill dialog. Choose White from the Contents menu, leave the 

Mode set to Normal, and Opacity at 100%. Click OK. You should 

have what looks like a negative of the original image. 

Step Four: For a clean extrac-

tion, we need the subject to be 

all white and the background 

black. The background is fine 

but we still have a lot of gray 

in the subject. To clean that 

up, press Shift-Delete (PC: 

Shift-Backspace) again, keep 

the Contents set to White, but this time change the blend Mode 

to Overlay, and leave the Opacity at 100%. Click OK. This will 

force a lot of the gray area to white and will leave the black back-

ground alone. Repeat this step a few more times to fully clean up 

all the gray areas. The result will be a perfectly clean mask. 
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Step One

Step Three

Step Four

http://kelbyone.com/magazine/issue/february-2015
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Step Five: Click the 

main RGB channel to 

reactivate it, go to the 

Layers panel, and make 

sure the Background 

layer is selected. Choose 

Select>Load Selection. In  

the Load Selection dialog, choose the Alpha 1 channel in the 

Channel menu, and load it as a New Selection. Click OK. Now 

press Command-J (PC: Ctrl-J) to copy the selected area to a new 

layer and voilà! Clean extraction. 

Step Six: Now that we have the sub-

ject removed from the background, 

let’s bring this image to a new docu-

ment to build the final design. Choose 

File>New and create a new document 

measuring 1000x560 pixels at 150 ppi. 

Choose the Move tool (V) and click-

and-drag the extracted subject into 

the new document. Press Command-T (PC: Ctrl-T) to enter Free 

Transform, and Shift-drag a corner handle to resize the subject. 

Press Enter to commit the transformation. Position her a little to 

the left side to make space for the splashes we’ll add in a bit.

Step Seven: Before we bring in the 

splashes, let’s boost the contrast of 

the subject with a quick little trick. 

Make a duplicate of the subject layer 

by pressing Command-J (PC: Ctrl-J), 

then remove the color by pressing 

Shift-Command-U (PC: Shift-Ctrl-U). 

Finally, change the Layer 1 copy blend 

mode to Soft Light, and drop the 

Opacity to 75%.

Step Eight: Now open the file containing the set of three 

splash elements. Notice these splashes are red, but you don’t 

need to concern yourself with color when searching for ele-

ments like this. You can always change the color. I like the 

solidity of these splashes, and they’re abstract so they can be 

configured pretty much any way. But first, we need to extract 

them from the background. 

Step Nine: We’ll use an extraction method similar to what we 

used earlier, but a bit different. Go ahead and open the Chan-

nels panel. Instead of making a luminosity-based selection, select 

the Blue channel, click the Channels panel flyout menu, choose 

Duplicate Channel, and click OK. Select the Blue copy channel, 

click the empty box to the left to make it visible, and click the 

Eye icon next to the Blue channel to turn it off. Now choose 

Image>Adjustments>Invert to create the negative image. Press 

Shift-Delete (PC: Shift-Backspace) to open the Fill dialog, and use 

the Overlay fill again to force the gray areas of the splash to 

white. Remember, it may take a few tries to get to pure white. 

Step Ten: Repeat Step Five to load the channel selection 

and copy the selected splashes to a new layer. Now choose 

Layer>Matting>Defringe, set the Width to 1 pixel, and click OK. 

This will clean up any anti-alias noise around the edges. 

Step Eleven: Choose the Lasso tool (L) and draw a selection 

around the middle-right splash. Grab the Move tool and click-

and-drag the selection to the main working file. Once there, 

you’ll need to rotate the object to determine the best position for 

it in relation to the subject. We placed this splash over the sub-

ject’s right leg. Press Command-T (PC: Ctrl-T) to enter Free Trans-

form and resize and reposition the splash. Now Right-click in the 

transform bounding box and choose Warp from the menu. We 

proceeded to basically sculpt the splash to the shape of the leg. 

When you’re done, press Enter to commit the change. 

Step Twelve: Now we need to match the splash color to the 

color of the subject’s leggings, which are a rather hot pink. Press 

Command-U (PC: Ctrl-U) to open the Hue/Saturation dialog. 

Click the Colorize checkbox in the bottom-right corner, set the 

Hue to 340, Saturation to 80, and click OK. 

Step Thirteen: The color matches pretty good, but I want to be 

able to see through the splash a little so I can see the legs. For 

that, we’ll use a feature that has been in Photoshop pretty much 

since the beginning. Select the layer containing the splash, click 

the Add a Layer Style icon (ƒx) at the bottom of the Layers panel, 

and choose Blending Options. At the bottom of the Blending 

Options, you’ll see the Blend If section where you can blend two 

layers based on the range of tones. In this case, go to the Under-

lying Layer sliders, hold down the Option (PC: Alt) key, and click 

on the black slider to split it. Now drag the right half of the black 

slider to around 128. This will allow for the darker shadow areas 

of the subject to peer through the splash. Click OK to close the 

Layer Style dialog. 

Step Fourteen: Let’s fade out the right side of the splash, as it’s 

merely excess that we don’t need. Click the Add Layer Mask icon 

(circle in a square) at the bottom of the Layers panel. Choose the 

Gradient tool (G), press D then X to make the Foreground color 

black, click the gradient thumbnail in the Options Bar, choose 

Foreground to Transparent (second option), click OK to close the 

Gradient Editor, and click the Radial Gradient icon (also the sec-

ond option). Drag out a series of gradients to remove the right 

side of the splash.Step Nine

Step Eleven

Step Twelve

Step Thirteen

Step Six

Step Five

Step Eight
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Step Seventeen

Step Eighteen

Step Fifteen

Step Nineteen
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Step Fifteen: Go back to the file containing the splash elements, 

and this time use the Lasso tool to select the splash on the lower 

left. This one will go over the subject’s left leg. Use Free Transform 

to resize and reposition the splash. Remember, when you have 

it in position, Right-click in the bounding box and choose Warp. 

Reshape the splash to better conform to the shape of the subject. 

Again, the shape is abstract, so you can get away with quite a bit 

of manipulation here. Press Enter to commit the changes.

Step Sixteen: With the 

splash in place, change the 

color using the settings we 

used in Step Twelve. Now 

click the Add a Layer Style icon and choose Blending Options. 

Again, split the black Underlying Layer slider and drag the right 

half to help blend the shadow areas of the subject with the 

splash, and click OK to close the Layer Style dialog. Use a layer 

mask if you need to hide any areas of the splash.

Step Seventeen: Now with the new splash in place, we have 

a small problem; the left arm is now behind the splash and we 

need it to be in front. For the moment, click the Eye icons for the 

splash layers to hide them, and select the duplicate subject layer. 

Press Command-E (PC: Ctrl-E) to merge the duplicate layer with 

the original. Choose the Quick Selection tool (W) and click-and-

drag over the subject’s left arm, making sure to get the entire 

hand and arm, at least as far as the elbow. Now click the Refine 

Edge button in the Options Bar. Nudge the Radius setting under 

Edge Detection up a little, set the Output To menu to New Layer, 

and click OK. 

Step Eighteen: Click-and-drag the arm layer to the top of the 

layer stack and turn on the visibility of the hidden layers. This will 

give the appearance that the arm is in front of the splash while 

the rest of the subject is behind it. 

Step Nineteen: Return to the splash file, select the final splash, 

and drag it into the working file. Follow Steps Eleven through Thir-

teen to resize, reposition, and change the color of the splash as you 

see here. We also have another splash file that’s similar to one of 

the splashes in the set, but this one has more detail and more scat-

tered elements. Repeat Steps Nine and Ten to extract this splash, 

then change the color and position this one under the previous 

splash to add volume to the overall effect. If these splashes cover 

the subject’s hand, simply drag the arm layer to the top of the layer 

stack. Now it looks more like a splash dress with multiple levels.

Once you have the blending and color matching sorted, you can 

continue to play with different arrangements of the splash, or even 

add more to it depending on the effect you’re going for. ■ 

http://www.topazlabs.com/mktg/psuser-lake.html
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We’re constantly showing you how to create effects with the latest and 
greatest Photoshop features. That’s awesome, but many of our mem-
bers (readers) are fairly new to Photoshop and haven’t learned some of 
the basic techniques we use daily (and sometimes take for granted). 
Even though layer styles have become a staple of our Photoshop work-
flow, it never hurts to revisit fundamental layer style techniques from 
time to time. These techniques are basic by design, but they can also be 
extremely effective and eye-catching. The logo for the new Annie movie 
is a great example of how simplicity can be effective. Let’s get back to 
basics and we’ll show you how we re-created it.

layer styles: back to basics
B Y  F E L I X  N E L S O N

Step One: Open the Annie_paths.psd download 

file. Click the Create a New Layer icon at the bot-

tom of the Layers panel to add a new layer (Layer 1).  

Click the Foreground color swatch at the bottom 

of the Toolbox, choose a red color (R:228, G:12, 

B:23), and click OK. Click the Background color 

swatch, choose a dark-red color (R:36, G:1, B:2), 

and click OK.

 [KelbyOne members may download the Annie_

paths.psd file used in this tutorial at http://kelbyone 

.com/magazine/issue/february-2015. All images 

are for personal use only.]

Step Two: Command-click (PC: Ctrl-click) on the Path 2 thumb-

nail in the Paths panel (Window>Paths) to load it as a selection. 

Choose the Gradient tool (G) from the Toolbox. Now click the 

gradient thumbnail in the Options Bar, choose the Foreground 

to Background preset, and click OK to close the Gradient Editor. 

Click the Linear Gradient icon on the left in the Options Bar. 

Click-and-drag a gradient from the top toward the bottom of 

the selection. Press Command-D (PC: Ctrl-D) to deselect.

Step Three: Click the Add 

a Layer Style icon (ƒx) at 

the bottom of the Layers 

panel, and choose Bevel & 

Emboss. Choose Smooth 

for Technique, set Depth to 

75%, and enter 8 px for Size. 

Check the Anti-aliased box. 

Enter 60° for Angle and for 

Altitude. Raise the Highlight 

Mode Opacity to 100%. Don’t click OK yet.

http://kelbyone
.com/magazine/issue/february-2015
http://kelbyone
.com/magazine/issue/february-2015
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Step Four: Click on the 

word “Contour” in the 

Styles list on the left side of 

the Layer Style dialog. Click 

on the down-facing arrow 

next to the Contour thumbnail and 

choose Ring – Double. Turn on Anti-

aliased, and enter 50% for Range. We’re still not ready to click 

OK yet.

Step Five: Choose Drop 

Shadow from the Styles 

list. Enter 55% for Opacity. 

Uncheck Use Global Light, 

and enter 113° for Angle, 

40 px for Distance, and 

40 px for Size. Click OK to 

apply the layer styles.

Step Six: Create a new layer 

(Layer 2). Press D to set the 

Foreground color to black. 

Load Path 1 as a selection. 

Go to Select>Modify>Expand. 

Enter 8 pixels and click OK. 

Now, press Option-Delete (PC: 

Alt-Backspace) to fill the selec-

tion with black. Deselect.

Step Seven: While holding 

down the Option (PC: Alt) key, 

click on the word “Effects” 

below Layer 1 and drag it below 

Layer 2 to duplicate the layer 

styles and apply them to Layer 2.

Step Eight: Double-click 

on Bevel & Emboss under 

Layer 2 to open the Layer 

Style dialog. Enter 4 px for 

Size. Choose Drop Shadow 

from the Styles list. Enter 20 

px for Distance and 20 px 

for Size. Click OK to apply 

the layer style changes.

Step Nine: Add another new 

layer (Layer 3). Press X to 

change the Foreground color 

to white, click the Background 

color swatch, and choose a 

light-gray color (R:207, G:213, 

B:227). Load Path 1 as a selec-

tion. Choose the Gradient tool 

and click-and-drag a gradient 

from the top toward the bot-

tom of the selection. Deselect.
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Step Ten: Add another layer (Layer 4). Change the layer blend 

mode to Overlay near the top left of the Layers panel. Load 

Path 2 as a selection. Choose the Brush tool (B) from the 

Toolbox. Using a large, soft-edged brush (about 300 pixels), 

paint a bright highlight area on the upper-center portion of 

the letters. Deselect.

Step Eleven: Open an image 

of a person’s silhouette. Using 

the selection tool of your 

choice, isolate the silhouette 

from the background. Copy-

and-paste (Command-C then 

Command-V [PC: Ctrl-C then 

Ctrl-V]) the selected silhouette 

into the Annie document. This will add a new layer (Layer 5). 

Step Twelve: Press Command-T (PC: Ctrl-T) to bring up the 

Free Transform bounding box. Resize the silhouette so it fits 

inside the dot of the letter “I.” (Tip: Press-and-hold the Shift 

key and click-and-drag a corner handle to resize and constrain 

the proportions.) Press Enter to apply 

the transformation. Click on the Add 

a Layer Style icon and choose Color 

Overlay. Click on the color swatch, 

choose red for the color, and click OK 

to close the Color Picker. Click OK to 

apply the layer style and complete the 

effect. ■ 

http://www.adorama.com
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Dirty
Tricks

If you look around on websites such as 500px you may come 
across an interesting image style that combines a portrait with 
a unique background that has a faux double-exposure look to 
it. This tutorial will show you an easy way to incorporate this 
technique into your own images. The goal of this exercise is to 
add drama and visual interest to your work with only a few key 
steps. The result will be a stunning, one-of-a-kind image that 
will have a lasting impact on both the audience and hopefully, 
if you’re the photographer, the subject of the portrait.

landscape portrait
B Y  P E T E  C O L L I N S

Step One: Start with a portrait. You’re going to want to use one 

that’s high contrast with a good bit of shadows and a pure white 

background. You can take a regular portrait and knock out the 

background and use dodging and burning to get the right look, 

but if you’re the photographer, try to shoot on a white back-

ground and light it appropriately. If you’re a graphic designer or 

just want to practice to see how things work, you can find great 

examples on stock sites. For this image, the search parameters 

were “shadow” and “portrait” with the added criteria of “iso-

lated” checked on under Options in the sidebar of Fotolia.com. 

This shot was about half way down the page, and the lady’s hair 

and profile is perfect for this look.

[KelbyOne members may download the files used in this tuto-

rial at http://kelbyone.com/magazine/issue/february-2015. 

All files are for personal use only.]

Step Two: We need to make sure that the background is com-

pletely white, so open the Levels dialog by pressing Command-L 

(PC: Ctrl-L). Choose the white Eyedropper icon on the right side 

of the dialog. With that Eyedropper over the background, click 

in an area that is supposed to be white. Click OK to close the 

Levels dialog.

Step Three: If there are any little stubborn areas that are still 

slightly off-white, simply grab the Brush tool (B), press D then 

X to set the Foreground color to white, and change its blend 

Mode to Overlay in the Options Bar. Now paint in the stubborn 

areas and only the parts that are lighter than medium gray will be 

changed to white while any darker areas will be left untouched.

©
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Step One

Step Three

Step Two

Fotolia.com
http://kelbyone.com/magazine/issue/february-2015
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Step Four: Find the appropriate background image. You can get 

creative and use many different types of images for this, such 

as a cracked desert floor, waterfalls, brick walls, etc. This image 

worked because her hairstyle seemed to be a natural fit for adding 

branches and leaves (sorry for that pun—it’s a sickness). Search-

ing for “autumn” and “branches” will help you find some good 

imagery that has the right combination of leaves and branches.

Step Five: You’ll want to change 

the color to black and white on each 

image. There are plenty of ways to do 

this, but one way that has the most lat-

itude is to choose Black & White from 

the Create New Adjustment Layer icon 

(half-white, half-black circle) at the 

bottom of the Layers panel. Now you 

can tweak the contrast of the image 

by moving the sliders for the individ-

ual colors. You’ll want to aim for a good bit of contrast in both 

images. Once you get the look you like, you can merge the Black &  

White adjustment layer and the background together by mak-

ing the adjustment layer active in the Layers panel and pressing 

Command-E (PC: Ctrl-E).

Step Six: Using the Move tool (V), drag the tree image into the 

portrait image. If the portrait image still has the Background layer 

locked, click on the Lock icon to the right of its name in the 

Layers panel and it will change to a regular layer. Now you can 

drag the tree layer below the portrait layer. Since you’re probably 

going to manipulate the size of this image, it might not hurt to 

Right-click on that layer and choose Convert to Smart Object.

Step Seven: Click on the black-

and-white portrait layer to make it 

active in the Layers panel, and press 

Command-J (PC: Ctrl-J) to dupli-

cate it. Hide the copied layer for 

a moment by clicking its Eye icon. 

Change the blend mode of the 

original portrait layer that’s directly 

above the tree layer to Screen. 

Any area that isn’t white on the portrait layer will reveal what’s 

beneath it in the layer below. Now the leaves appear as if they 

were cut out using the portrait as a guide.

Step Eight: Make the tree layer active and press Command-T 

(PC: Ctrl-T) for Free Transform. Now you can rotate, flip, or even 

warp the branches to help accentuate the drama of the portrait. 

In this example, we moved the tree layer slightly down and to the 

left and increased its size a little. Press Enter to commit the trans-

formation. The branches of this image work well to give a sense 

of uplifting serenity and peace to the portrait. That’s what you’re 

trying to find, a combination of images that works together to 

convey a feeling that enhances the impact.

Step Nine: Once you have the branches set where you want 

them, go to the duplicated portrait layer, click where its Eye icon 

used to be to reveal it, and make it the active layer. Change the 

blend mode of this layer to Multiply. Press-and-hold Option (PC: 

Alt) and click on the Add Layer Mask icon (circle in a square) at 

the bottom of the Layers panel. This will add a mask filled with 

black, which hides the entire layer.

Step Five

Step  Seven

Step  Eight

Step Six

Step Four
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Step Ten: Now simply choose a soft-

edged white Brush. In the Options Bar, 

set the blend Mode to Normal and the 

Opacity to a low amount. Paint in the 

areas that you want to reveal of the 

model’s face and clothing. Paint mul-

tiple strokes to reveal more of an area. 

If you get too heavy-handed just press 

X to switch to black and paint away 

any extra parts. This is where you get to add your artistic tastes to 

how the images interact.

Step Eleven: Now add some simple, elegant text for a won-

derful advertising piece or a poster, or try it with a color image 

instead of black and white—it still works the same. This would 

make a great option for a mom or dad to create portraits of their 

kids using background images and textures that tell a bit about 

the personality of each kid. 

Now that you know how to make this wonderful image, the 

quest is going to be to find the right combination of images that 

creates the biggest impact. It may even lead to you seeking out 

textures and taking pictures of things that you want to use for the 

perfect image, so have fun. ■ 

D O W N  A N D  D I R T Y  T R I C K S  › ›

Step  Ten

Step  Eleven

http://www.reallyrightstuff.com
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DesignMakeover
C O L U M N  ›  ›

JAKE WIDMAN

“Paff put up a website via 
Google Sites around 2008—he 

compares it to an art blog.”

Charley Paff is the nom de pinceau of Charley Paffenbarger, a com-

puter systems and network administrator at the University of Califor-

nia, Berkeley Seismological Lab. Since he moved to California in the 

1960s, he’s been introducing himself as Charley Paff, and when he 

took up painting in 2001, he adopted it as the name he’d paint under.

“My artistic background started when I was very young,” says 

Paff. He took art classes in high school and worked in architecture 

through the 1980s. After being away from it for a while as he pursued 

his IT career, he realized he missed it and started taking figure drawing 

and painting classes. Call it a “midlife adult reeducation,” he says.

Paff put up a website via Google Sites around 2008 to give him-

self the opportunity to communicate and explain what he does—he 

compares it to an art blog. At the moment, he doesn’t try to sell his 

art through the site: “I have a day job, so I’m not as focused on trying 

to sell, though I am open to it.” But he doesn’t think his work looks 

like what people shop for on art-for-sale websites, and he relishes 

the freedom to experiment that the lack of a commercial purpose 

gives him.

He also makes ad hoc business cards himself to hand out at his 

exhibitions and to leave a business card at the occasional juried show 

he participates in. 

He recognizes that his current site doesn’t represent his art very 

well. “Visually, it has next to no appeal,” he says. He blames it on his 

scientific background—much of his work for the past two decades 

has involved sitting in front of text-heavy webpages. Ideally, he’d like 

something engaging that has some wit. A new site should “put a 

smile on somebody’s face,” he says. We asked three designers to give 

Paff a wittier Web presence with business cards to match.

artist’s statement
It was my goal to create a clean identity flow between Charley’s 

work, website, and business cards. I used large images of Charley’s 

work in both projects to visually represent his work. Larger, color-

ful images on smaller mediums, such as a business card, will easily 

distinguish and set apart his collateral from others while maintaining 

the integrity of the identity system. The slide show on Charley’s web-

site serves a similar purpose, allowing the visitor to easily recognize 

Charley’s work. 

Charley’s current website offers a vast amount of information, 

but it lacks organization and a sense of unity. For the redesign, 

my goal was to create a space that was easy to navigate while 

retaining a visually simple layout. Since the site is an artist’s cyber 

representation, I didn’t want the artistic focus to be anywhere but 

on Charley’s work.

I chose four colors, pulled from his current paintings, and created 

a color profile to establish a relationship between gallery hung can-

vas, paper business cards, and his website. For the webpage, I used 

Adobe Illustrator for a majority of the layout and Photoshop to cre-

ate the transparent layer of canvas on Charley’s slide show to convey 

his medium and to give the slide show definition. For the business 

cards, I chose four images, each highlighting one of the four theme 

colors, and created four simple, informative contact cards. The trans-

parent canvas layer is applied to each of these cards, as well. 

I chose to employ a simple sans-serif typeface as to not distract 

from Charley’s work. It will complement a wide variety of art medi-

ums and styles. Charley’s website and cards can easily be updated 

with a change of color and image as his artistic style grows and 

develops. Both communicate a strong identity, yet leave an open-

ness for his creative influence to be reflected.“I chose four colors, pulled 
from his current paintings, and 

created a color profile….”

APPLICATIONS USED: Adobe Photoshop and Adobe Illustrator

ANGELA MATERNOWSKI
Angela Maternowski, owner of Ela V Creative, is a creative thinker, big dreamer, and active doer. She enjoys being bound into creative knots, just 
to process how they become unraveled. She awakens daily with a burning passion to create, whether it’s placing a bit of wit throughout copy, 
developing a branding system for a nonprofit, or carefully blending enough skim milk to her coffee to uncover a light-hearted caramel tone.

Besides design, she is on her way to becoming a yoga instructor. Despite her gypsy soul, Angela is a bit of a homebody, with a few quirky 
life objectives. She believes in giving it your all, and presenting the best of you that you can each and every day, professionally as well as 
personally. Her creativity is as necessary to her life as breath.

about the designer

before

CLIENT
Charley Paff 
http://sites.google.com/site/charleypaff/art

makeover submissions
WE’RE LOOKING FOR PRODUCT PACKAGING OR LABELS, PRINT ADVERTISEMENTS, WEBSITES, AND MAGAZINE COVERS THAT ARE CURRENTLY IN THE MAR-
KETPLACE FOR FUTURE “DESIGN MAKEOVERS.” SO IF YOU OR SOMEONE YOU KNOW HAS A DESIGN THAT YOU’D LIKE US TO CONSIDER MAKING OVER, OR 
IF YOU’RE A DESIGNER AND YOU’D LIKE TO BE CONSIDERED FOR A FUTURE “DESIGN MAKEOVER,” SEND US AN EMAIL AT LETTERS@PHOTOSHOPUSER.COM. 
(NOTE: THIS IS PURELY A DESIGN EXERCISE AND THE DESIGNERS DO NOT WORK DIRECTLY WITH THE CLIENT, CREATE FUNTIONING WEBSITES, ETC.)

 ›  ›  D E S I G N  M A K E O V E R

DESIGNER
Angela Maternowski 
http://elavcreative.com

after
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I wanted to present Charley and his work in a socially connecting 

fashion that helps his audience quickly engage with his images and 

the artist. To do this, I felt his artwork and narrative needs to be 

center stage and somewhat in your face, but not obnoxiously so.

With this redesign, I presented five of his pieces as introductions 

to his style, cropping them to tease viewers into wanting more. The 

homepage is topped with a distinctive new logo I created using 

Blackoak Std Regular, which also acts as a homepage button, and 

text navigation on top right set in Avenir Medium. The naviga-

tion link drops down to an expanded chronological list of Charley’s 

work, along the lines of what’s on his current site.

In the center of the homepage, the cropped images link to 

other pages with the full works shown along with their descrip-

tions. On these related pages, the structure would include a blog 

setup for viewers to add their comments.

To provide art lovers with more access to Charley and his work, 

I included social media buttons in the lower-left corner, and an 

expanded Upcoming Shows text box with information and a link 

at the lower right. Also in the lower left is a subtle link for Charley 

to log in and add new text and images to his pages.

For the business card makeover, I mimicked the image of the 

homepage on the front, while emphasizing the new logo, keeping 

it clean and simple. On the back of the card, I used another image 

of Charley’s as a bleed, incorporating his name (in Blackoak Std) and 

contact info (in Avenir Medium) into a niche of the artwork layout.

THOM VALLANCE
Thom discovered his interest in graphic design as a kid, illustrating and writing his own children’s books. In tenth grade, his commercial art 
teacher, Paul Ender, began grooming Thom’s talents, introducing him to layout and identity design, then eventually publication design as the 
chief editor of the 300+ page yearbook. Mr. Ender transitioned Thom to California State University, Chico, where he got his communication 
degree with Greg Berryman.

As an art director, his work has appeared in The Art of the Gun: Magnificent Colts (Yellowstone Press), which has been on exhibit at the 
Metropolitan Museum of Art and the Nevada Museum of Art. As a freelancer, he has worked with Aflac Insurance, Alpine Meadows Resort, 
Cisco Systems, Peppermill Casino, and VisitAuburnCA.com.

Thom enjoys living in south Reno, Nevada, with his wife and three kids, where they love to ski, hike, bike, and hang out on Lake Tahoe beaches.

APPLICATION USED: Adobe Photoshop CC 2014

Creating any sort of marketing materials for a fine artist begins with 

determining what is unique about his product and then finding a 

creative way to present that to the viewer. Every artist has an indi-

vidual style and method, so that makes it easy—and at the same 

time, challenging. 

In creating a landing page for Charley Paffenbarger (who goes 

by the name Charley Paff), I wanted to showcase his unique style 

and use of color. But at the same time, I felt it would be to his 

advantage to place multiple samples of his artwork on the page, 

like paintings in a gallery. Of course, space is always at a premium, 

so the sample images I chose are carefully cropped to offer the 

viewer a partial look at the entire piece, with the full image just a 

click away. 

As for fonts, a simple sans-serif Helvetica works well, reversed 

from the solid black background, and the Paff signature is lifted 

directly from the canvas.

On some of my preliminary designs, I explored a different 

approach that included a more corporate logo, but decided on one 

that would be unique and personal, which is the Paff brushstroke 

logo. It’s the one constant that would appear on every painting, 

and like a fingerprint belongs to the artist. And I think people like 

that personal touch.

I included these elements on the business card to tie in with his 

landing page. The small thumbnails of some of his artwork tell the 

viewer who he is and what he does—no title necessary.

APPLICATIONS USED: Adobe InDesign CS6 and Adobe Illustrator CS6

MICHAEL SARCONE
Michael Sarcone is a graduate of the College of Design at Iowa State University and now lives in West Des Moines, Iowa. He has more than 
30 years of experience in design and art direction and has spent the last seven at FBL Financial Group, Inc., a large insurance and financial 
products company, where he’s an art director. In addition to his 8–5 job, he has a diverse list of freelance clients who provide him with a variety 
of ongoing projects. Not surprisingly, many of his clients are agriculture and insurance related—businesses that drive the economy of Iowa. 

When not in front of the Mac, Mike can be found in the garage tinkering on an old British sports car, going to a farmer’s market, or work-
ing on a never-ending list of home-improvement projects. He’s married with three children, all currently in college or graduate school. ■ 

about the designerabout the designer

“…I felt his artwork and narrative 
needs to be center stage 

and somewhat in your face, 
but not obnoxiously so.”

“...the Paff brushstroke logo [is] 
the one constant that would 

appear on every painting, and like 
a fingerprint belongs to the artist.”

DESIGNER
Thom Vallance 
www.thomvallance.com

after

D E S I G N  M A K E O V E R  ›  ›  ›  ›  D E S I G N  M A K E O V E R

DESIGNER
Michael Sarcone 
https://www.behance.net/gallery/Michael-Sarcones-Portfolio/959996



Images: Pam & Tara Photography Except Where Noted
Intro Art: Dollar Photo Club; Layout Design: Taffy Clifford
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By Paul Hebron

bringing them all together

a creative who seeks collaboration. This is extremely important to me because I don’t like 
working in a vacuum. I have several go-to friends that I can call on for brainstorming and 
bouncing around ideas. Most designers I know do the same thing, especially when it comes 
to self-branding. If there’s a time when I second-guess my decisions, it’s when I’m working 

on my own promotional material. Even though I can use the same processes I use for clients, it’s still hard to be objective on my 
own brand.

How about you? As a photographer, do you hire or consult with a designer when you work on your own promotional 
material? What should you consider when creating your brand? Are you able to be objective when trying to create your 
own branding material? Do you know how to position your business? What’s the first step in your process?

We’ll find out why one photography business decided to use a designer. Then we’ll ask that very same designer to 
give some tips that might be helpful toward you making a decision to either do it yourself or call on a designer to help 
your brand. 

Tara Nalani started with photography in her teenage years. Her dad 

is a photographer who specialized in portraits and weddings. Tara 

would help him out at weddings by carrying equipment, moving hair 

out of the bride’s face, and that sort of thing. She remembers going 

with him to drop off film back in those days and having to wait for 

it to be processed. She can’t even imagine doing film today. “With 

digital, we’re a bit spoiled, being able to see images instantly in the 

back of our cameras.” 

PAM              TARA   
PHOTOGRAPHY:  
WWW.PAMANDTARA.COM

She also started scrapbooking in her teenage years. She 

learned to story tell through the photo albums she created. 

Eventually, her hobby started to grow and she purchased a 

DSLR and continued shooting with her dad. It all seemed to 

grow organically from there. Friends and family would say, “Hey, 

Tara, you have a camera; you should take our pictures.” She 

purchased books, studied online, and started using what she 

learned from her dad. Eventually, she began trying out new 

things with the camera. Having friends and family that allowed 

her to experiment on was fun. The next thing she knew she was 

starting a portrait and wedding photography business, and now 

she gets paid for her craft. 

http://www.pamandtara.com


› 
› 

k
e

l
b

y
o

n
e

.c
o

m

051

› 
› 

p
h

o
t

o
s

h
o

p
 u

s
e

r
 ›

 F
E

B
R

U
A

R
Y

 2
0

15

050

When I asked Pam and Tara why they chose to hire someone to do 

their branding, Tara said, “If you look at us, we’re very different. Even 

our likes are different, but because we’ve been friends for so long, 

we obviously have some things in common. We didn’t know how 

to pull the common things out to mesh together as a brand. That’s 

why we hired a professional to help us do that. We’re not experts in 

design or branding at all. We know how to take pictures and then 

edit and share them, but branding and trying to present ourselves as 

a holistic brand is not within our skill set.”

Tara goes on to say that finding a designer can be challenging 

because there are so many out there to choose from, “especially 

if you base it only on what you see online.” One day Tara was 

watching a CreativeLive show online called “Restart: A Pho-

tography Business Makeover” with photographer Jasmine Star. 

Jasmine brought on three photographers who wanted to do a 

business brand makeover. They pulled in different graphic design-

ers to assist the photographers with the rebrand. That’s when 

Tara discovered Meg Long who was one of the designers on the 

show. Meg designed the visual brand for Nikki Closser, a Wash-

ington photographer, and Tara was impressed by not only the 

end results but also how Nikki described the working relationship.

Tara contacted Meg for an initial phone consult. Tara said, 

“We hit it off and decided to work together at that point. Having 

that connection with her on the phone was important.”

Pam said, “Once we selected Meg. She gave us homework to 

complete. There were things we needed to gather on Pinterest 

boards, such as fonts that we liked, colors, and other things that 

would reflect our individual personality. We also had a few Goo-

gle chats and communicated via email. I’m not super hip on social 

media, so everything was kind of new to me. It was interesting 

to see how she identified each of our personalities without really 

knowing us.” 

THE DESIGNER: MEG LONG OF 
GO LIVE HQ (GOLIVEHQ.CO)
Meg Long was working as a full-time designer and creative man-

ager at a nonprofit when one of her wedding photographer friends 

needed a website designed. They decided to trade services. This work 

snowballed into one referral after another. Other photographers saw 

Meg’s design work and she began freelancing on the side. Eventually, 

90% of Meg’s freelance clients were photographers. 

Fast-forward a few years when designer Promise Tangeman of 

Go Live HQ (formerly Sitehouse) contacted Meg and asked if she 

wanted to partner with her in doing a CreativeLive session called 

“Restart” with Jasmine Star. Meg was paired with a photographer 

out of Washington to design her site. Meg says she got about a 

hundred inquires on the day it was featured on the CreativeLive 

site, which enabled her to quit her full-time job and she began her 

design business full-time in March of 2013.

It was scrapbooking that led Pam Conchas to 

her current passion for photography. She began 

in her teens and said, “I almost never left home 

without my camera. As a teenager, I was the 

photographer in our group of friends.”

Pam also began taking in-the-moment photos 

of her husband and two daughters, photo- 

cataloging everyday moments and special occa-

sions for family and friends. Because of her back-

ground in scrapbooking, she says she is able to 

look with a nontraditional eye. Her goal is to cap-

ture the right shot at the right moment to create 

lasting memories for her clients. Pam says, “My 

photos are real-life moments. Not always per-

fectly posed, but spontaneous photos that cap-

ture the true essence of the moment.”

TWO BECOME ONE
Pam lives in the San Diego area and Tara lives in 

the Seattle area. The two photographers have 

been friends for more than 25 years. Both photog-

raphers have their own portrait photography busi-

nesses. Tara said, “Any time we booked a wedding, 

we’d call the other one to help out. Weddings can 

be a large and long ordeal. Having the extra set 

of hands can be helpful. Someone can focus on 

the bride and groom, while the other focuses on 

the guests. It’s just nice to have the two sets of 

hands. When we first started shooting weddings 

together, it became a bit confusing because cli-

ents would ask who was the main photographer 

or which company we were shooting under. Even 

though we both have our own separate businesses, 

we decided to partner as wedding photographers.”

Both photographers worked well together 

and said they seemed to know what the other 

was thinking at times, even though they are dif-

ferent in other aspects. Tara and Pam realized 

they needed to create and present a brand for 

this new partnership that would represent both 

of their styles.

PAM         TARA  
PHOTOGRAPHY HIRE  
SOMEONE TO CREATE  
A BRAND

http://GoLiveHQ.co


 

One of Tara’s Instagram posts where she was doing the brand safari prompts. 
Some of the brand safari photos ended up on the website.
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DIY  VS. HIRING A DESIGNER
I asked Meg if photographers should ever use free services to build 

their website and do their own branding. Meg responded, “It depends 

on the photographer. If you’re starting out, shooting whatever you can 

to make some money and just grow your business, this is really smart 

in a lot of ways, especially if you don’t really know what you want yet. 

But I think once you start to refine your photography and editing style 

and know who your ideal client is, sometimes it’s really helpful to have 

that person to bounce ideas off of. It’s hard to make those decisions 

by yourself, especially about your own brand. It can be hard to be 

objective. At that point, it’s really helpful to have some kind of brand-

ing expert, a designer to go through that process with and legitimize 

where you are at this point, especially if you’re ready to compete and 

take your business to the next level.

“I recommend people not to invest in design if I can tell they 

are uncomfortable with spending the money on design. I found 

it doesn’t usually go well when somebody can’t really afford it 

because they are stretching themselves and maybe taking on some 

debt to go through a design process. It tends to put a lot of pres-

sure on the design process and that’s not really good. I especially 

think this happens to young photographers where they have a little 

money to start with and they’re not sure if they should invest in 

design or something else.”

Meg goes on to say that if the photographer isn’t sure and 

they’re “waffling between design and taking a workshop to 

improve their craft, then take the workshop or something that will 

build your photography skills.” Design isn’t the silver bullet that’s 

going to grow your business if you have other things that you’re 

not confident in. I’ve had people wait, focus on their skills, and 

come back a year later and say, ‘Okay, I’m ready.’”

When I asked Meg how she decides if she’s going to work with 

a client or not, she stated, “I generally don’t turn too many people 

away. I think it’s pretty clear in the work that I do that I have a 

certain style. Someone described it once as whimsical editorial. So 

that doesn’t fit everybody. Most of the time, when people con-

tact me, it’s because they have already seen my work, or a friend 

referred them. Most of my inquiries are a good fit for me, but when 

they’re not, it’s usually a style thing. Sometimes it’s money. A lot 

of people when they are starting out in photography want to right 

away invest a bunch of money in design, and I actually don’t think 

that’s the very best way to use their money if they’re only a few 

months in the business. I think it’s better for them to invest in their 

photography and build that up because the website is never going 

to look the way they dreamed if their photography isn’t where they 

want it to be.

 “I always recommend waiting a little bit until you’re a little more 

financially stable and you know what your brand is and the direc-

tion you want to go; know what kind of photography you want to 

focus on and then contact a designer. Sometimes I get inquiries like 

that and I try to steer them to some lower-cost options to get them 

started. Occasionally, I’ll have somebody who really wants a par-

ticular style, say super minimalistic or masculine style. If their vibe 

is such that I’m not going to honor as well as some other designer, 

I’ll usually refer them to one of my designer friends that might be 

The initial creative questionnaire that Meg sent to Pam and Tara. This pro-
vides basic business info and then helps them verbalize their vision, goals, and 
brand aesthetic.

a better fit for them. I’m always eager to make sure they’re fitted 

with a designer that will be equally enthusiastic about the vibe that 

they want to go for.”

MEG’S DESIGN PROCESS
After a client books Meg, she’ll invite them to Basecamp, the proj-

ect management system she uses to keep everything organized. She 

says most designers she knows use a project management system to 

avoid having hundreds of emails floating back and forth. Once the 

client is invited to Basecamp, Meg will have homework assignments 

already waiting for him. 

“I’ll have a questionnaire they’ll need to fill out. It’s a four-page 

PDF with different questions. Some of it just collects basic busi-

ness information, such as your business name and social media 

links. From there the questions are, can you tell me about your 

business, can you describe your business in one sentence, if your 

business were a person what would their personality be like, what 

does your brand stand for, etc.? I want to know what makes 

them unique and sets them apart. Who is their target customer 

and so on.

“We also do what I call a brand safari. This is where they have 

to take a picture of something every day for 30 days. I will use 

the results of the safari to peel apart the onion of their business 

to understand what their values are, their aesthetics, and other 

things that they might not be able to communicate verbally, but 

they can communicate through pictures.” These photos are not 

random photos; Meg has created 30 photo prompts designed to 

give her insight into what the clients’ visual and aesthetic values 

are and what makes them unique.

As Pam and Tara mentioned earlier, 

Meg will have clients do specific types 

of Pinterest boards: one for typography, 

one for texture and shapes, and the last 

one for color. Meg requires that the client 

write a note on each Pin describing what 

they like about it. She says the notes are 

helpful in identifying exactly what they 

like about each Pin. From there, Meg is 

able to recognize a pattern. She says she 

might use Skype to discuss the question-

naire, the safari images, or the boards. 

Meg regularly communicates with the 

client to make sure she understands the 

visual values representing their business. 

In some cases, she might create a sepa-

rate Pinterest board that culls what she 

thinks is the direction from the boards 

that they’ve created, and together, they 

might tweak it from there.

Pinterest board Meg created where she consol-
idated some of the ideas, colors, textures, and 
typography from both Pam and Tara's individ-
ual boards into a more unified direction.
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Mood board images left column top to bottom:
www.etsy.com/shop/Grepic
www.bhg.com
http://kel.by/1BdsmcR
www.houzz.com

Mood board images right column top to bottom:
http://eeryelegance.blogspot.com
http://owensolivia.blogspot.com
www.thibautdesign.com
http://kel.by/1D0yeIL
http://www.damasklove.com

Mood board Meg created after they all agreed that they liked the direction of the consolidated 
Pinterest board. This served as a road map for the colors, textures, typography, and overall tone 
that they wanted to achieve as they moved into the logo and website design phase.

Next, Meg creates a formal mood board, 

a collage of the items they selected on Pin-

terest along with the images from their brand 

safari. The mood board also includes her sug-

gested fonts along with a suggested color 

palette. Mood boards may go through a few 

revisions until Meg and her client are in total 

agreement about the visual look and feel of 

the brand. After all this, Meg will then go into 

the actual logo and website design.

“Most of my clients will hire me to do brand 

identity, research, logos, secondary logo and 

brand elements, the portfolio website, and a 

separate blog.” Meg says the process after 

the research can take 4–6 weeks, depending 

if they’re doing a blog along with the website.

I asked Meg if she ever gets requests from 

photographers to create a website in a very 

short amount of time? She replied, “Yes, and 

actually this is where I should talk about Go 

Live HQ, a creative firm I now work with full-

time. Something I’m really passionate about 

is improving the design process so that it 

isn’t so long—to make it more fun and effi-

cient, because the sooner a business gets a 

great website, the sooner their business can 

grow and attract their target clients. I feel like 

there’s a space for a long, drawn-out brand-

ing process, but for a lot of small businesses, 

they just need something up that looks amaz-

ing—and they want it fast. Go Live HQ—com-

prised of creative director Promise Tangeman, 

me, another designer named Liz Grant, and 

our creative manager Ash Gardner—is a 

firm dedicated to helping entrepreneurs go 

live with a knockout site very quickly. We’ve 

refined a homework process that is very simi-

lar to what I did with Pam and Tara: question-

naires, Pinterest boards, etc. Our clients have 

about a month to do the homework. Then 

once we start, depending on which service a 

client books, it’s anywhere from one day to 

two weeks from beginning to end—a custom 

logo design and website design in a matter of 

weeks, which is pretty cool. We’ve had really 

amazing results with this; some clients have 

even tripled their business.”

Here’s a look at the three rounds of logo design.
THE LOGO DESIGN PHASES

The logo concepts Meg presented for the first round of the logo design phase.

Round 2 of the design phase.

These are the final logos chosen by Pam and Tara. Logo Designs: Meg Long Creative
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The final website design that can be seen at www.pamandtara.com, includ-
ing the homepage, a gallery page, and their blog.

Working with Pam    Tara
Finally, I asked Meg what was it like working with Pam and Tara, 

business partners located in different states?

“It was really fun. Working remotely wasn’t an issue since most 

of my clients are remote. I’ve only worked with one other client 

that was in my same city. I’m pretty used to working with people 

who are far away. I think it makes us be more intentional about 

making sure we were all on the same page with the direction and 

the visuals. Whenever you have more than one decision maker, 

there is the potential for one person to have an idea for the brand 

and the other person has a different idea. It can be a little difficult 

to make everyone get on the same page. All three of us were 

aware from the get-go that this might be a challenge that we 

had to address.

“Pam and Tara were super thoughtful about doing their home-

work, the Pinterest boards, and answering questions about their 

brand. Whenever we chatted, they were very forthright about 

their different ideas and their vision for the brand. Because they 

have such a good connection with each other, I think that made 

it a lot easier to get us all on the same page and get excited about 

a direction. They were amazing to work with.”

Meg recommends the photographer be honest with the 

designer. Let the designer know if the work doesn’t reflect what 

represents you. Be honest throughout the entire process. Don’t 

think you’ll hurt the designer’s feelings if you don’t like some-

thing. A professional designer expects collaboration. If you have 

trouble making decisions and you have no idea what you want at 

all, then before you hire a designer, you might want to do some 

soul searching and think about your business goals, if this is the 

right time to do this, and your style.

Meg said, “Sometimes people come into the design process 

and don’t know what they want and I can help them understand 

what they want if they are able to participate in the process. They 

don’t have to go into this 100% sure what they want, but I think 

they need to be honest and ask, “Can I make a decision?” Some-

times people hire a designer and they want the designer to take 

the entire design process away from them and do everything. It’s 

good for photographers to understand it’s going to be a collabo-

ration. They will need to be involved in the process, and honesty 

is very important. Design is a collaborative process.”

Tara recommends hiring a professional, especially if you’re 

partnering with another photographer. She said it’s import to get 

an understanding of who you are. The key word is “research.” 

Research who you are, your personality, and what vision you’re 

trying to project to your potential clients. Hiring a designer takes 

the stress away from trying to do it on your own.

Pam agrees. “With me being a newbie to social media, it 

was amazing to see how Meg nailed Tara and me. I don’t think 

we would have been able to get our brand to reflect us so well 

because we are so different.” 

Calling on a designer to bring your brand to the surface is valuable 

and might help you discover strengths you might have overlooked. If 

you can’t afford to hire a designer, don’t go broke trying. You might 

consider doing it yourself or finding a designer willing to barter. If you 

do the work yourself, ask your clients and friends to help you identify 

your key attributes that set you apart.

If you can afford a designer, make sure that the designer 

spends time helping you identify your visual fingerprint, what 

makes you unique. You should already know what style of pho-

tography you’re focusing on and the ideal client you’re seeking; 

the designer can help you hone in on making your brand unique. 

Just be prepared to do a little homework up-front and embrace 

collaboration with the designer. ■
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LESA SNIDER
Beginners' Workshop
 eight mistakes in Photoshop

Perform each edit on a separate layer: Layers are your key 

to safe and flexible editing. By color correcting on one layer, zap-

ping blemishes on another, etc., you can back out of any edit 

anytime you want—even after closing the document. You can 

also lower the Opacity of individual edits (layers) to make each 

change look realistic (crucial in portrait retouching). As you’re 

about to learn, there are many ways to edit on separate layers, 

including duplicating a layer by pressing Command-J (PC: Ctrl-J); 

however, try to employ adjustment layers whenever possible. The 

first 16 commands in the Image>Adjustments menu are avail-

able as adjustment layers (choose Layer>New Adjustment Layer), 

wherein the adjustment occurs on a separate layer. Adjustment 

layers also come with a layer mask, saving you the step of adding 

one in order to hide that layer’s content from parts of the image. 

They also make it easy to duplicate an effect onto another image; 

just drag-and-drop relevant adjustment layers from the Layers 

panel into another open document.

Use fill layers: Instead of adding an image layer and filling it with a 

solid color, gradient, or pattern, use the Layer>New Fill Layer com-

mand. How is this exciting? Let us count the ways. First, fill layers 

let you experiment with other colors, patterns, or gradients; just 

double-click the fill layer’s thumbnail to reopen the Color, Pattern, 

or Gradient Picker. Second, fill layers come with a mask that lets 

you hide the fill from parts of your image, which is perfect for add-

ing digital makeup, as shown in the first image and Layers panel 

on the right, or when colorizing a black-and-white image (in fact, 

if you create a selection prior to adding the fill layer, the fill is visible 

only inside the selection). Third, fill layers automatically resize them-

selves to match canvas size when you increase it. Hip hip hooray!

Use empty image layers instead of duplicate layers: Some 

tools can function on empty layers, alleviating the need to dupli-

cate the whole thing. This maneuver keeps your document size 

lean by having fewer pixels on layers (note the two healing brush 

layers in the first Layers panel shown above) and makes it easy 

to locate the area you changed (Option-click [PC: Alt-click] that 

layer’s visibility Eye icon to see only its content). Position the empty 

layer at the top of your layer stack and use the Options Bar set-

Each version of Photoshop comes with new features that let you work smarter instead of harder; however, old 
editing habits are hard to break, especially if you’ve been using the program for a long time. In this column, you’ll 
learn how to avoid several mistakes that siphon the editing flexibility from your documents.

tings shown on the previous page to turn on the tool’s Sample All 

Layers checkbox or set its Sample drop-down menu to Current &  

Below or All Layers. This trick works with the Spot and Heal-

ing Brush tools, the Patch tool (set its mode drop-down menu 

to Content-Aware to reveal the Sample All Layers checkbox), 

the Content-Aware Move tool, the Clone Stamp tools, and the 

Sharpen tool. Unfortunately, the Fill dialog’s (Edit>Fill) Content-

Aware option in the Contents drop-down menu can’t be used 

on an empty layer, so use it on a duplicate layer or stamped copy 

instead (described next).

Instead of merging or flattening layers, use a stamped 
copy or a smart object: Many tools and commands, includ-

ing filters, only work on single layers, but if you merge or flatten 

them, you lose edibility. The solution is to create one layer from 

many using a stamped copy or smart object. To create a stamped 

copy, press-and-hold Option (PC: Alt) and choose Merge Visible 

from the Layers panel flyout menu shown here, or press Shift-

Option-Command-E (PC: Shift-Alt-Ctrl-E). Photoshop then com-

bines all visible layer content onto a new layer; just drag it to the 

top of your layer stack and edit away.

Alternatively, you can sandwich layers into the protective 

wrapping of a smart object. Shift- or Command-click (PC: Ctrl-

click) to activate your layers in the Layers panel and choose 

Layer>Smart Objects>Convert to Smart Object, and your lay-

ers disappear from view in the Layers panel. Expand the smart 

object by double-clicking its layer thumbnail, causing your layers 

to open in a temporary document. Simply make your changes, 

choose File>Save (not Save As), close the temporary document, 

and the smart object updates itself in the original document. 

Use smart filters: To run filters safely on single or multiple lay-

ers—whether for retouching or compositing—first activate the 

layer(s) and choose Filter>Convert for Smart Filters; Photoshop 

sandwiches them into a smart object. Now after you apply cer-

tain filters from the Filter menu, you can reopen the filter anytime 

for more editing (double-click its name in the Layers panel); hide 

the filter’s effect from parts of your image using the included 

mask (circled and used here to lessen the filter effect on her 

eyes); change the filter’s blend Mode and Opacity (double-click 

the icon to the filter’s right to open the Blending Options dialog); 

or delete the filter by dragging it to the Delete Layer icon (trash 

can) at the bottom of the Layers panel. A variety of filters were 

applied here to create a painted effect. 

Convert to smart object before resizing image layers: Each 

time you transform an image layer to resize it, you lose qual-

ity. After as few as three size changes, quality loss can become 

noticeable. To preserve quality, convert the layer(s) to a smart 

object as described earlier and resize that instead. Due to its pro-

©
ph

ot
og

un
s/

Fo
to

lia

©
pr

es
sm

as
te

r/F
ot

ol
ia



B E G I N N E R S '  W O R K S H O P  › ›
› 

› 
p

h
o

t
o

s
h

o
p

 u
s

e
r

 ›
 f

e
b

r
u

a
r

y
 2

0
15

060

tective wrapping, you can resize smart object content until the 

cows come home without making pixel pudding. (The Content-

Aware Scale command in the Edit menu doesn’t work with smart 

objects, so use it on a duplicate layer or stamped copy instead.)

Use the Properties panel to feather masks and adjust 
mask opacity: It’s better to feather layer masks than selections 

because you get a preview and you can alter feather amount after 

closing the document. For example, to create a soft-edged selec-

tion, say, for a soft oval vignette collage, create a selection with 

the Elliptical Marquee tool (nested under the Rectangular Mar-

quee tool [M] in the Toolbox), click the Add Layer Mask icon (circle 

in a square) at the bottom of the Layers panel, and then double-

click the mask’s thumbnail. In the resulting Properties panel, use 

the Feather slider to feather on the fly. The Density slider is handy 

for adjusting mask opacity. Just double-click any mask—even the 

one you get with smart filters—to summon these sliders. 

Get out of Photoshop: Omnipotent as it seems, Photoshop isn’t 

always the best place to edit imagery. For example, it’s far easier in 

Adobe Camera Raw than in Photoshop to correct exposure, color, 

and overexposed skies (use the Graduated Filter [G]); remove sen-

sor spots; fix perspective and geometric distortion; smooth skin 

(use the Adjustment Brush [K] set to a negative Clarity setting); 

create split tones and black and whites; sharpen; and add edge 

vignettes. Camera Raw is installed with Photoshop and opens 

when you double-click a RAW-format image; however, you can 

access a version of it in Photoshop CC by choosing Filter>Camera 

Raw Filter (be sure to use smart filters).

That said, Adobe Photoshop Lightroom can do all that and 

more. Imagine the Camera Raw plug-in plopped atop a powerful 

database that you can use to import and organize your images. 

Lightroom lets you copy-and-paste or sync changes across multi-

ple photos, heal and clone, create virtual image copies for experi-

mentation, create export presets for resizing and watermarking, 

and make pro-level photo books, slide shows, print templates, 

and Web galleries. It’s included in both Creative Cloud Photogra-

phy and full Creative Cloud subscriptions. Any edits you make in 

the Camera Raw plug-in or in Lightroom are 100% nondestruc-

tive, meaning you can undo them anytime you want.

As you can see, these tips will keep your documents as flexible 

as they can possibly be. Until next time, may the creative force 

be with you all. ■
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Layout Design: Taffy Clifford

© Massimo_g/Dollar Photo Club

©Syda Productions/Dollar Photo Club

As I mentioned before, I’ve used stock 

imagery for years. I go to stock image sites 

for various reasons. One is simply to get 

ideas and inspiration. Most stock image 

sites not only offer photos, but they also 

provide graphic elements such as logos or 

even fully illustrated artwork. Some even 

offer video and animation clips—all which 

are reasonably priced. I’ll browse the library 

and feed my creative incubator and let the 

ideas start to swirl around. Try it sometime.

However, you’ll often find yourself in 

need of a specific image or subject matter. For instance, in my work I’m often 

looking for subjects to use in complex composites, such as movie posters. Well, to 

get the best image possible, I not only need to find the right subject, but it also 

needs to be shot in a way that makes the compositing task easier. I’m going to 

extract the subject from whatever background they’re on, so it’s best to find a 

subject that’s been shot in a studio setting with very basic lighting on a white or 

even gray background. 

This makes the process of extraction much easier than if the subject were shot 

in a crowded party, or where there’s little contrast between the subject and back-

ground. Look for images that are isolated on white or gray backgrounds; for exam-

ple, I’ll do a search for a businesswoman on a white background. This helps narrow 

the search to what I’m looking for. If I just searched for businesswoman, then  

I would get back thousands of results. 

As a designer, I’ve used stock images for years. They’re a designer’s secret weapons, and 

these days there are so many resources for acquiring royalty-free stock images that you rarely 

have to shoot your own images, but in some cases, there are things you might need that no stock 

resource will have. I remember back in the old days when you had to order stock images on a 

CD from companies like PhotoDisc. One disc would cost hundreds of dollars and have maybe 50 

images. With modern-day stock sites such as Fotolia.com and DollarPhotoClub.com, you have millions 

of images ready to download at the click of the mouse, and they’re actually affordable. 

Whether you’re a designer that’s looking for good stock imagery, or a photographer that 

wants to shoot stock images to sell to a stock resource, keep reading because we’re going to 

approach this from both angles. As a designer, what to look for when you’re shopping for stock 

images really depends on the project at hand, but I have some simple guidelines that will help 

you better navigate when searching. As a photographer, there are some things you need to 

consider when shooting stock images to make it easier for the designer that will be using your 

images. Even if you’re just shooting for yourself, I have a few tips to keep in mind to make your 

post work in Photoshop much easier. 

P H O T O G R A P H Y  S E C R E T S  › ›

By Corey Barker

©Sergey Nivens/Dollar Photo Club
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Another thing to consider is design elements. In a lot of my work, I use people and elements like fire, water, or any object 

that might be relevant to my project. Let’s say I need to find a picture of a piece of tape so I can make something look like it 

was taped to a wall. I could do a search for a specific type of tape and that will be all I get, but here’s a cool tip: When you’re 

searching for elements, try to find images that have a large variety of that element in one file like the stock image shown here 

of many different kinds of tape in a single image. The beauty here is that you’re only paying for a single image but you get a 

collection of design elements. I do this all the time with elements that I need for a project like this example of brushes shown 

here. It’s just about being a little bit smarter when you’re doing your initial search.

Let’s take a look at this from the photogra-

pher’s approach. If you’re a photographer and 

you want to start shooting your own library 

of stock images, or if you plan on selling your 

images to a stock resource, then there are a few 

things you need to consider. I asked my Photo-

shop User TV co-host, Pete Collins, to weigh in 

on this part because he’s had some experience 

with producing stock imagery for sites such as 

iStockphoto.com.

When shooting for stock, you have to put 

yourself in the mind of the end user, because 

the better you understand what a designer or 

artist may be looking for, the better chance 

you have that your images will be purchased 

over others.

Lighting:
Be sure to light your subjects very evenly. Avoid overly 

dramatic lighting scenarios as this limits the design-

er’s options. That doesn’t mean there isn’t a place for 

images with dramatic light; just keep in mind that they 

tend to get overlooked by designers. For example, this 

image would be great if the background were simpler 

for the purpose of extracting. It’s just too dark, espe-

cially at the bottom, which leaves very little contrast of 

the subject to the background.

Backgrounds:
Because most designers and artists will need to extract 

the subject from the background, you need to make 

that job as easy for them as possible. Shooting sub-

jects on white, gray, or even black backgrounds is 

the best idea, bearing in mind that lighting is key. 

Avoid shooting subjects on a green screen. That’s 

mainly for video production, and in photography the 

green reflects on the subject, which is overly appar-

ent when you extract the subject and place him or 

her on a different background.

This also applies to any inanimate design element 

or even fire, smoke, or dirt. In fact, one time I took 

a large piece of white paper and tossed some dirt 

on it to get a scattered particle effect. By using the 

white paper, I was able to extract the dirt easily.

Another thing a designer or artist might consider is video. Many stock sites offer short video clips and animations in various 

resolutions. I’ve used many stock video clips for many reasons, but a video clip is merely a series of stills that show some pro-

gression. I’ve actually downloaded time-lapse videos, such as rolling clouds, and extracted frames from these high-resolution 

clips to use as backgrounds in static designs. That means I have several hundred cloud images. With Photoshop being able to 

open and edit video clips, you can extract several different cloud configurations from a single video clip. 
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Textures:
Textures are a big deal with designers these days and you can never have too many in your arsenal. Like people, 

you want to shoot textures with even lighting and preferably straight on, meaning you need to be perpendicular 

to the texture you’re shooting to get an even texture. I shoot a lot of textures with my DSLR and even with my 

iPhone. I also use a lot of stock textures. The best kind is seamless textures, which will tile in Photoshop with no 

obvious seams. 
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Collections:

As I mentioned earlier, it’s of great benefit to the designer to offer elements that are part of a collec-

tion contained in a single image. If you’re the photographer putting together these collections, you 

can assemble them on one set and shoot them, or you can shoot the individual elements and then 

assemble them into a single document in post. 

Clipping paths: 
Another thing to consider, especially with products and other elements, is to create a clipping path 

for the object. It’s a little more work but it will be a better option for designers, as they won’t have 

to deal with the labor of extracting the element themselves. In many cases, designers will choose 

these types of images over others just for the timesaving aspect.

Hopefully this gives you a better idea of what to consider, whether you’re looking for stock images for your design work or 

if you’re shooting stock images for designers. Efficiency is key, and as the photographer, the easier you make it for the end user the 

better chance your images will sell. ■

Corey Barker ©Imaster/Fotolia ©Moenez/Fotolia
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T he environment is a critical part of the shot, 

and contributes heavily to the success of 

the image. Living in Colorado, I have many 

studio choices. Recently, I had a chance to photograph 

a mountain biker in between rides. My assignment was 

to create an engaging environmental portrait.

Successful environmental portraits hinge on three prin-

ciples: good rapport, relevant location, and solid technique. 

Connecting with your model and establishing good rapport 

will enable you to create better images and hopefully an 

honest shot. On many shoots I run through the paces with 

my subject, trying different poses and getting nice images. 

After working with my subject a while, she starts to relax 

and open up to the camera. I get more honest expressions 

and capture a real connection between subject and pho-

tographer—always a magical moment on a portrait shoot. 

Next, the environment has to be relevant and import-

ant to the image. Environmental portraits allow the pho-

tographer to tell a story in the single image by using the 

location as a storyboard for the portrait. A raging rapid 

in the background of a kayaker portrait hints at the seri-

ousness of the sport and the ability of the kayaker. 

Finally, good portraits require solid camera technique: 

lighting, aperture and shutter speed, perspective, and angle 

of view are the variables photographers use to express their 

vision in the final shot. Let’s take a look at how these prin-

ciples worked on the mountain biking shoot.

STEP ONE
Scout the location. Mountain biking traditionally takes place 

in the mountains on rugged trails, so a mountain location 

makes sense. I decided to scout a rocky ridge with good 

views in the distance. Since I would be shooting in late after-

noon sun, I needed a spot where the model could position 

herself with her back to the sun but still look natural sitting 

on her bike on the rocks. 

I found a nice spot but I had a small problem. Snow 

patches covered the rocks and I didn’t want bright white 

snow spots in my final shot. I always carry a broom with me 

on shoots (sweep out glass from alleys, dirt off streets, etc.), 

so I swept off the snow and let the sun melt what was left. 

Another useful thing to do is stand exactly where you 

want your model to be. Is it comfortable? Safe? Where is 

the sun? I often change things up after I position myself 

as the subject, and this also helps me visualize poses. The 

only other location issue was a power line in the back-

ground. Since I would be shooting at a shallow depth of 

field for my final shot, the power lines wouldn’t be visible. 

STEP TWO
Casey, the mountain biker, arrived and we were ready to go. 

Casey is classic Colorado: healthy, fit, and loves any outdoor 

activity in the mountains. I’ve photographed her many times, 

› › L I G H T  I T

BEING AN ADVENTURE SPORTS PHOTO-

GRAPHER, MY STUDIO CHANGES ON A  

DAILY BASIS. ONE DAY I MIGHT BE FLOAT-

ING IN A RAPID SHOOTING A KAYAKER, 

AND THE NEXT DAY HANGING OFF A CLIFF 

PHOTOGRAPHING A ROCK 

CLIMBER. OR MY FAVORITE, 

THE TRIPLE-HEADER: SHOOT 

CLIMBER IN MORNING, KAY-

AKER MIDDAY, AND MOUN-

TAIN BIKER AT SUNSET, ALL 

ON THE SAME SHOOT! 

 >>LIGHT IT

HIGH
ROCKY  
MOUNTAIN

By  
Tom Bol

so rapport was a given. Even better, she models and knows 

exactly what to do in front of the camera. 

We chose a combination of helmet, gloves, clothes, 

and bike that would look good. Within about 10 min-

utes, she was on the bike ready for action. The weather 

changed for the better as clouds started rolling in, which 

meant she could face any direction without squinting 

into the sun. As much as I like bluebird cloudless days 

in Colorado, clouds make photographs more interesting. 

STEP THREE
Available light would not work for this shot. The overhead 

clouds created soft, flat light. While soft light might work 

fine for some portraits, I wanted dramatic shadows and 

contrast to match the thrill of mountain biking. I brought 

my Elinchrom Rangers along to light the shot. These packs 

have 1,100 watts of power, which is plenty of juice to over-

power the bright sun. To trigger the lights, I used Elinchrom 

Skyports, which also allowed me to adjust power from the 

transmitter on my Nikon D800. I used Elinchrom Free Lite 

S heads with the Rangers. The S heads have a slower flash 

duration than the A heads, but because this was a static 

shot, it didn’t matter. 
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STEP FOUR
For the first image, I used an Elinchrom 39" Rotalux Deep Octa-

Box, my favorite softbox for athletic portraits. The deep profile of 

this softbox adds a nice edge to the light, somewhere between a 

traditional softbox and a beauty dish.

With any portrait there are two lighting ratios to determine. 

First, what’s the lighting ratio between your lights? Second, what’s 

the ratio between your lights and the ambient light? In the studio, 

ambient light is often not an issue; your strobes are the only lights 

illuminating the subject. But with environmental portraits, ambi-

ent light and your location are an important part of the shot. 

I started by shooting in manual mode and establishing the 

ambient outside light to be one stop underexposed from the 

correct exposure. Underexposing the background one stop 

shows the background, but in a muted way that doesn’t com-

pete with the subject. When the subject is illuminated by flash, 

she pops off the background. 

STEP FIVE
Honestly, I was already feeling like I had a good shot. The Octa-

Box illuminated Casey with a nice specular light, and the dark-

ened background and clouds gave the image an edgy feel.  

But I’m always game for more lights! I decided to add a second 

L I G H T  I T  › ›

light opposite my main light. This light was an Elinchrom Ranger  

S head with a 30° grid attached. The grid would focus the light 

on Casey’s shoulder and prevent spill onto the rocks. I powered 

this light up to be about one stop brighter than the main light. 

Using two lights this way is classic cross-lighting, great for sep-

arating a subject from their background. I was shooting at f/16 

with this series of images to keep the back ground in focus, but 

I decided to mix things up and shoot using a wider aperture to 

soften (blur) the background. 

STEP SIX
I moved Casey for a different angle and changed the 

power on my lights so I could shoot at f/5.6. Shooting at ISO 

100 under a dark sky allowed me to shoot at f/5.6 and still 

have a correct background exposure. If it had been brighter, or 

had I wanted to use a wider aperture opening, I would have 

attached a two-stop neutral-density (ND) filter and powered 

up my lights to compensate for the ND filter. 

Because we were still working on the cliff’s edge, the 

only way I could secure my gridded accent light was by jam-

ming my light stand into a crack in the rock. This worked 

great, and we were able to create another series of images 

with nice background bokeh. 

STEP SEVEN
In the final shot, I like the balance and overall feel created by the 

scenic location and edgy cross-lighting. I processed my favorite 

images with Topaz Adjust 5 using the Dynamic Pop II preset set 

to about 50% Opacity. This action adds grit to the image and 

enhances the clouds, which works well for an adventure sports 

environmental portrait. ■

› › L I G H T  I T
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›  ›  l i g h t r o o m  ›  ›

In this tutorial, we’ll work on a single land-

scape image of a small island near Makapuu 

Point on the island of Oahu in Hawaii. We’ll 

transform the washed-out RAW original into 

a rich and dramatic color image and then 

explore an alternate, moody black-and-

white interpretation.

 Developing 
Landscapes

and Taking 
Snapshots

B Y  S E Á N  D U G G A N

Along the way, you’ll use the snapshots feature to make a 

record of each significant processing step so you can easily click 

through them to see what each change brought to the image 

as part of the overall transformation. This can be a great tool for 

teaching Lightroom and makes it easy to track the processing 

progress of an image.

step one: If you’re working along with this tutorial using 

the Duggan_6406_Island.dng image, go to the Lens Correc-

tions panel in the Develop module and turn on Enable Profile 

Corrections and Remove Chromatic Aberration. Since the hori-

zon is slightly crooked, click on Level in the Upright controls to 

straighten the image.

[KelbyOne members may download the file used in this tuto-

rial at http://kelbyone.com/magazine/issue/february-2015. 

All files are for personal use only.]

step two: I like to use 

snapshots in Lightroom, not 

only to create a record of 

different creative interpreta-

tions, but also to document 

how the image looks at key 

points in the process. This is 

an optional part of this tu-

torial, but if you want to be 

able to quickly see how each 

adjustment step affected the 

image, it’s very useful. To create a new snapshot, go to the Snap-

shots panel on the left side of the interface and click the Create 

Snapshot icon (+). Name the snapshot “01_Lens Corrections,” 

and click Create. As we continue working on the image, we’ll 

make a new snapshot for significant adjustments, making it easy 

for you to review how each change has enhanced the image.

step three: Next, open the Basic panel to adjust the overall 

brightness and contrast for the photo. Feel free to experiment 

with settings that please you for this image, but I set Exposure 

to –1.10 and Contrast to +18. By lowering the Exposure, the 

shadows of the rocks get too dark, so lighten these by raising the 

Shadows value to +85. Finally, to enhance the midtone contrast 

edges, set the Clarity to +40, and add some pop to the colors by 

increasing the Vibrance to +31. These simple adjustments go a 

long way to making the image look much better, but there’s still 

more we can do. Before moving on, save a new snapshot and 

name it “02_Basic.”

step four: Open the Tone 

Curve panel and apply a slight 

S-curve to increase the con-

trast. You can do something similar with the Contrast slider in 

the Basic panel, of course, but in most cases I prefer to use the 

Tone Curve to apply contrast adjustments because I can vary 

how each of the four major tonal regions is affected. The name  

S-curve refers to the curve’s slight resemblance to the letter 

S, and it’s a common contrast adjustment that can work well 

on many images. To match the S-curve we used here, set 

Highlights to +30; Lights to +15; Darks to –10; and Shadows 

to –30. (Note: If you don’t see the four sliders in the panel, 

http://kelbyone.com/magazine/issue/february-2015
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Start gradient here

End gradient here

›  ›  l i g h t r o o m  ›  ›

click the little curve icon at the bottom right of the panel.) Save 

a new snapshot and name it “03_Tone Curve.”

step five: We’ve done a lot so far with overall adjustments 

to the image. Now it’s time to get local with changes that we 

can apply to specific areas of the photo. Click the icon for the 

Graduated Filter (fourth from the left just under the Histogram), 

or press the letter M. In the tool’s panel, set Exposure to –0.50; 

Contrast to +40; and Clarity to +40. Position your cursor approxi-

mately halfway between the top of the image and the top of the 

island and drag down until the bottom line of the Graduated 

Filter is a short distance below the horizon (hold the Shift key 

to constrain the filter to a horizontal orientation). Create a new 

snapshot and name it “04_Graduated Filter-Darken Sky.”

step six: Now we’ll move 

on to making changes to im-

age areas with irregular shapes 

that won’t work with either the 

Graduated Filter, or its compan-

ion, the Radial Filter. We’ll use 

the Adjustment Brush to lighten 

the shadow detail in the dark rocks, and also to make modifica-

tions to the island. Click the icon for the Adjustment Brush (sixth 

from the left just under the Histogram), or press the letter K.  

If any previous settings are still in place, you can reset all the slid-

ers for this tool by double-clicking the word “Effect” at the top 

of the panel (this also works for the Graduated and Radial Filters). 

Set the Exposure to 0.75 and the Shadows to 30. The brush Size 

should be about 7.0, the Feather 100, and Flow and Density can 

both be 75. Make sure the Auto Mask checkbox is enabled.

Lighten the Rocks: Paint over the dark rocks to lighten them. 

Once you start to see changes appear, you can adjust the sliders 

if necessary. Keep the crosshair that appears in the center of the 

brush on the area you want to affect. The Auto Mask setting 

will prevent it from spilling outside that area. Press O to see the 

red overlay view of the area that’s affected by the adjustments, 

then press O again to hide it and resume your work. The nice 

thing about the Adjustment Brush is that you can always refine 

step seven: Press Y to see a Before and After view. The im-

age is looking much better than when we started! Press Y once 

again to return to the current version of the photo. Now that we 

have a good color version, it’s time to branch out and explore an-

other creative interpretation. To do this in a way that allows us to 

compare our different versions side by side, we’ll use virtual cop-

ies. To create a virtual copy, use the shortcut Command-’ (PC: 

Ctrl-’), or you can also find this command in the Photo menu, or 

by Right-clicking on the image.

step eight: Press V to convert the virtual copy to black and 

white, then save a snapshot named “07_Default B&W.” In the 

B&W panel, adjust the sliders to modify tonal values based on 

the original colors in the image. For instance, with this image,  

I moved the Orange, Yellow, and Aqua sliders to the right to light-

en the sand and the lighter parts of the water near the beach, and 

dragged the Blue slider to the left to darken the ocean, as well 

as the clouds. Save a new snapshot called “08_Custom B&W.”

step nine: Return to the Tone 

Curve panel and increase the con-

trast by spreading the sliders out 

a bit more. Set Highlights to +55; 

Lights to +25; Darks to –25; and 

Shadows to –70. This creates a 

darker and more brooding feel for 

the scene. Make a snapshot called 

“09_BW Tone Curve.”

step ten: Make the Adjustment Brush active and click on 

the brush pin on the island. Increase the exposure to 1.70 to 

lighten the island cliffs some more. Create a snapshot for this 

step named “10_Island Adjustment for BW.” Click the Adjust-

ment Brush icon to close its panel.

the adjustment sliders after you’ve defined the area that will be 

affected. To track the progression of the changes in the image, 

save a new snapshot and name it “05_Lighten Rocks.”

Customize Contrast for the 

Island: With the Adjustment 

Brush still active, click the 

New button at the top of the 

panel. Set the Exposure to 

1.10, the Contrast to 20, and 

the Clarity to 35. The brush 

Size, Feather, Flow, and Den-

sity settings can be the same 

as the previous adjustment. 

Auto Mask should be turned 

on. Press the Spacebar to 

temporarily change to the 

Zoom tool and click on the 

island to zoom in to a 1:1 

view. Paint over the lighter, 

exposed areas of the cliffs 

on the right side of the island 

to lighten them. Click the Adjustment Brush icon to close its 

panel. Make a new snapshot and name it “06_Lighten Cliffs.”

step eleven: Open the Split Toning panel. In the Highlights 

section, set Hue to 40 and Saturation to 20; in the Shadows 

section, set Hue to 210 and Saturation to 10. This adds a sepia 

or warm tone to the brighter tones and a subtle cooler tone to 

the shadows. Make the usual snapshot of this step and name it 

“11_Split Tone.”

step twelve: Open the Radial Filter panel (fifth from 

the left just under the Histogram, or press Shift-M) and set 

the Exposure to –0.88 and the Shadows to 66. Place the cur-

sor in the center of the image 

and click-and-drag outward to 

apply a Radial Filter that dark-

ens the outer parts of the im-

age. The Shadows adjustment 

Before

After adjustment

Mask view

Before additional lightening



› 
› 

p
h

o
t

o
s

h
o

p
 u

s
e

r
 ›

 f
e

b
r

u
a

r
y

 2
0

15

076
ALL IMAGES BY SEÁN DUGGAN

prevents the rocks from becoming too dark. Make a twelfth 

snapshot and name it to describe the adjustment.

step thirteen: To make the island stand out more in the 

image, I added a new Adjustment Brush pin that lightened the 

sky area above the horizon and just above the island (the Expo-

sure was set to 0.80 for this change). That’s it. If you saved snap-

shots as you followed along, now 

you can click on various snapshots 

to see how your settings changed 

the image over time, or you can 

click on a snapshot and then take 

the image into a totally different 

direction from that point. ■ 

Before

After

Black-and-white interpretation
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›  ›  l i g h t r o o m  ›  ›

Under 
the 

Loupe
Photographing winter scenes brings its own set of challenges 

due to the weather. Similarly, processing those same scenes in 

Lightroom presents unique challenges due to the variable lighting 

conditions and the abundance of reflective snow.

processing winter scenes  
in lightroom
B Y  R O B  S Y L V A N

One of the things I love most about living in New Hamp-
shire is that we get to experience the best that all four 
seasons have to offer. One of my favorite seasons for get-
ting out of doors is winter because even the most ordi-
nary scene can become magical after being draped with a 
blanket of snow. And there are no mosquitoes!

dealing with underexposure
Correcting underexposure is one of the most common 

problems with snow scene photographs due to how the 

reflective snow can trick the camera meter into underex-

posing the scene. This is obviously best corrected at the 

time of capture by using positive exposure compensation, 

shooting in Manual mode, or exposure bracketing the 

scene (I have a few other tips for shooting in snow at the 

end of this tutorial). I usually shoot in Manual mode and 

bracket, but for the sake of demonstration I’m going to 

start with a photo that was shot at the correct exposure as 

determined by the camera while in Aperture Priority mode 

with no exposure compensation. As you can see it’s about 

a full stop underexposed. 

One of my goals when processing a snow scene is for 

the snow to appear white yet still retain some texture. 

Whether you’re exposing for the scene at the time of cap-

ture or when adjusting exposure in Lightroom, you always 

want to avoid losing detail in the highlights. Because the 

photo was underexposed, we know the highlights have 

not been clipped, but now we need to take steps to mini-

mize making existing noise more visible as we brighten 

the image.

I typically have a top-down approach for processing in 

the Develop module, with one exception: the camera Pro-

file found in the Camera Calibration panel at the bottom 

of the right-side panels area. For snow scenes I prefer to 

start with a lower-contrast camera profile to help bring out 

more detail in the highlights and shadows, so in this case  

I went with Camera Standard. The choices for camera pro-

file will vary with the camera model you’re using (and only 

apply to RAW files), so try each one you have to see what 

works best for your photo. From there, it’s back up to the 

Basic panel to address white balance and tonal values. 

balancing act
White balance can be tricky for snow scenes due to the 

reflective nature of snow and the evocative nature of color 

casts on the viewer. It’s no surprise that snow looks blue 

under a clear blue sky, while it can look a soupy grayish-

yellow under overcast skies. Since snow scenes depict a 

cold environment, I prefer a white balance that is a tad 

cooler than neutral to help convey that feeling of cold-

ness. I had the in-camera white balance set to Daylight in 

this photo, and that’s not too bad. If I were to switch it 

to Cloudy, it would go too warm for my taste. If there’s 

something in the scene that’s neutral, you can use that 

with the White Balance Selector tool (W), but clicking on 

the snow itself can yield mixed results.
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I always carry a ColorChecker Passport in my pack and 

take a shot of it in these conditions just to have as a ref-

erence. With the shot of the ColorChecker as the most 

selected photo and the photo of my scene also selected, 

I can enable Auto Sync and simply click the light gray 

swatch on the ColorChecker to set a neutral white bal-

ance to both photos at once. (Note: If you see the Sync 

button, click the switch to the left of the button to enable 

Auto Sync.) This gives a much more natural result with-

out the snow getting too warm. Depending on the scene  

I may use the Temp slider to cool it down a little for effect. 

No matter what you use for a starting point I find manu-

ally tweaking the white balance adjustment usually gives 

me the most preferable result. 

setting the tone
Now I can move on to adjusting tonal values, starting 

with Exposure. For this photo, I want to increase the 

Exposure slider at least a full stop. Having the snow end 

up with RGB percentages in the low 90s should yield 

white snow with detail. My next move is to reduce the 

Contrast slider to help reveal texture in the snow (reduc-

ing contrast also reduces saturation and that works well 

for many winter scenes). We’ll add snap to the photo 

later with the Tone Curve.

As I continue down the Basic panel, I’ll reduce High-

lights to bring out that snow detail and increase Shadows 

to brighten the darker parts of the image. Now I feel that 

I’m in a good place to set the white and black points with 

the Whites and Blacks sliders, respectively. I like to work 

with the highlight clipping indicators turned on in the Histo-

gram, which can be done by pressing the J key, to alert me 

if I’m pushing it too far (seeing red tells me I’m clipping my 

highlights and blue indicates the blacks are being clipped). 

An automated way to set the white and black points is to 

press-and-hold the Shift key and double-click each slider 

label in turn. It’s not unusual to have to go back and tweak 

Shadows and Highlights to fine-tune the adjustment. 

make it curvy
At this point I’ve suc-

ceeded in brightening the 

overall image to where 

it should be, preserved 

detail in highlights and shadows, and added back some 

contrast to what was becoming a flat scene. Now I want 

to finesse the contrast using the Tone Curve panel. 

The Tone Curve can be used to add or reduce con-

trast, as well as brighten or darken parts of an image. 

I want to remain mindful of my highlight detail, but 

I also want that snow to look a nice, bright white. 

At the same time, darkening the Darks and Shadows 
regions will add back the amount of contrast I want 

in the scene. 

There are a few ways to apply adjustments with the 

Tone Curve, but I find it easiest to make these adjustments 

by dragging the respective sliders while visually evaluating 

the change made to the photo. 

eye in the sky
True to most landscape photos, you may have to deal 

with the sky separately from the foreground using the 

Graduated Filter (M). In this case, I applied a Graduated 

Filter over most of the sky, reducing the Exposure by 

almost another half of a stop, darkening the Highlights 

a little more, and increasing the Shadows to brighten 

the parts of the treetops and hills that were inadver-

tently affected by the Graduated Filter. Press M to close 

the filter.

a time to sharpen
The next set of adjustments I want to make in Lightroom 

are in the Detail panel. Because I was correcting an under-

exposed photo, I want to do what I can to mitigate any 

noise I made more visible, and I want to enhance good 

detail with capture sharpening. For a landscape photo, a 

great place to start is the Sharpen – Scenic preset found 

under Lightroom General Presets in the Presets panel. 

The only setting I want to change here is Masking. 

This preset sets Masking to 0, which means the sharpen-

ing settings are being applied to all pixels in the image.  

I don’t want to make noise more visible by sharpening it, so  

I want to increase the Masking amount to limit sharpening 

to just important detail edges. Hold down the Option (PC: 

Alt) key while dragging the Masking slider and you’ll see 

the mask that Lightroom is generating based on the edges 

in the image. White areas will receive the full sharpening 

amounts and the black areas get no additional sharpen-

ing. It can help to zoom into an area of smooth color, like 

the sky, where there’s no detail you want sharpened, and 

keep increasing the Masking slider until that area is nearly 

(or completely) black. That will go a long way in the quest 

to avoid enhancing noise. If there’s still some noise pres-

ent, go down to the Luminance Noise Reduction slider 

and increase it to finish the job. Remember, it’s usually 

better to have a little noise and good detail than no noise 

and mushy detail. 



› 
› 

k
e

l
b

y
o

n
e

.c
o

m

083

shortcut (PC: Ctrl-S). The menu command for this is Save Metadata 

to Files and can be found in the Metadata menu in the Library mod-

ule, or the Photo menu in the Develop module. You can also have 

Lightroom automatically write all changes to XMP by choosing this 

in the Metadata section of the Catalog Settings dialog. Catalog 

Settings can be found 

in the Lightroom menu 

on a Mac, or in the Edit 

menu on a PC (or it can 

also be accessed via 

a button in the lower 

right of the General sec-

tion of the Preferences).

use collection names as keywords
Saving the metadata to an XMP file will preserve any text-based 

metadata you’ve added (keywords, copyright notices, captions, 

descriptions, contact info, etc.), as well as the Develop settings, 

but the one thing that isn’t saved here are the names of any col-

lections an image may be a part of. If you have spent a lot of time 

arranging images into collections as part of your organization 

process, that’s a big blow to lose all that work if you have to start 

from scratch with a new catalog. 

One potential way around that is to add the collection name 

as a keyword to any images in the collection (ideally it would be 

useful to have a collection setting that did this for you automati-

cally). To do this, Right-click on a collection and choose Rename. 

Then, just highlight and copy (Command-C [PC: Ctrl-C]) the name 

of the collection and Cancel the Rename Collection dialog. Next, 

with the images in Grid view (G) in the Library module, select all 

the images (Command-A [PC: Ctrl-A]) in a given collection and 

then paste (Command-V [PC: Ctrl-V]) the copied collection name 

into the keywords field in the Keywording panel for all the files 

in that collection. If you ever have to reimport from scratch, that 

information in the XMP file will be recognized by Lightroom and 

you can then use the keyword search capabilities to isolate just 

those images and rebuild your collection structure. ■

Let’s face it, calamities sometimes happen, in real life and in our 

digital lives. Fortunately, there are a few things you can do in 

Lightroom to mitigate any digital disasters that may befall your 

image catalog.

back up the images, back up the catalog
Okay, this one is so obvious, but it always bears repeating, espe-

cially for new users. Always have at least one backup of your 

image files on a separate hard drive (two backups—one kept 

offsite—is even better!). This backup is one you have to handle 

on your own (meaning Lightroom doesn’t do it for you), either 

manually or by using backup software. Lightroom can handle 

the backup of the catalog for you, however, and you should 

definitely take advantage of this. In the General section of the 

Catalog Settings dialog (Lightroom [PC: Edit]>Catalog Settings) 

you can specify how often Lightroom prompts you to back up 

the catalog. I have mine set to Every Time Lightroom Exits. That 

doesn’t mean I actually back it up every time I quit the program, 

but if I’ve done a lot of work on the catalog in that session, then  

I typically will back it up. Backing up the catalog protects it 

against a hard drive failure, of course, but it can also be critical in 

case the catalog becomes corrupted and you need to revert to an 

earlier, noncorrupted ver-

sion. Lightroom creates 

a new folder for each 

backup. Typically, I only 

save the most recent five 

of six backups and delete 

the older ones.

write changes to xmp
Lightroom stores the changes you make to the file (i.e., keywords, 

Develop settings, etc.) in the catalog database. In a dire situation 

where you have to ditch the catalog and reimport images into 

a new catalog, you’ll lose all of that work. By writing changes 

into XMP files, however, that metadata, including any Develop 

module settings, is stored in XMP sidecar files that reside in the 

same folder as the images. When these images are imported into 

a new catalog, Lightroom will see those XMP files and all your 

previous metadata and Develop settings will be applied in the 

new catalog. I’ve worked with a number of clients where this 

has saved the day when they had to reimport images they had 

done a lot of work on.

You can save the metadata into XMP files on a case-by-case 

basis by selecting a group of images and using the Command-S 
ALL IMAGES BY SÉAN DUGGAN

SEÁN DUGGAN

ADOBE PHOTOSHOP   Lightroom Section ›  ›

& TipsTricks
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revisiting older photos
This is the usual approach I have to all snow scenes with 

the difference in settings mainly being driven by how 

good the original exposure was to start out. I went back 

to some photos taken in 2011 and found this shot of 

my dog chest deep in snow. It looked to be completely 

blown out, but then I realized it was imported into Light-

room before we had Process Version 2012 (under Process 

in the Camera Calibration panel). By simply updating the 

photo to PV2012 (click the lightning bolt icon in the His-

togram panel), all of the highlight detail was recovered. 
The steps in my process to correct this photo were exactly 

the same as the one before except that I moved the Expo-

sure slider in a negative direction (very slightly) this time 

since it wasn’t underexposed. I usually finish these types 

of photos in Lightroom with an increase in Clarity to give it 

another touch of snappiness before sending to Photo shop 

to do any needed retouching and creative sharpening.  

I leave you with some tips for shooting in winter:

• Keep spare batteries in inner pockets.

• Use a lens hood to keep falling snow off glass.

•  Fingerless gloves and hand warmers make a good  

combo for dexterity and comfort.

•  Put the camera in a case before coming inside to  

prevent fogging. ■
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id you ever compose an image and ask yourself why the composed objects look sort of fake? Well, maybe it was because they 

don’t have the right shadows. It’s not complicated to create a physically correct shadow, but there are a few things that you 

should consider. There are three types of shadows, and the good news is all three of them can be created in Photoshop.

Let’s start with shadowed areas on buildings or other objects. Imagine a tall building that’s lit by the sun from the left. The side facing the sun 

is brightly lit; the side not facing the sun is a lot darker and has considerably less contrast. This type of shadow can simply be painted onto the 

building using a Levels adjustment layer and a layer mask. But that’s not all: the building itself creates a shadow, as well. This type, the so-called 

drop shadow, is a bit more complex to build, but with a little Photoshop strategy it’s not a big problem. The third type of shadow is an effect 

you can see. For example, if you observe a cup on a table, there’s a thin black line between the cup and the table surface. This thin black line 

is very important to make a shadow look real. Let’s begin by taking a look at all three types of shadows.

[KelbyOne members may download the files used in this tutorial at http://kelbyone.com/magazine/issue/february-2015. All files 

are for personal use only.] 

In this simple image, you can see all three types of shadows. The 

main light source comes from the upper-left corner and divides the 

sphere in a bright, sunlit part (1) and a darker one that has a lower 

contrast (2). On the right side of the sphere we see the cast shadow, 

which is basically a projection of the sphere’s shape (3), and right 

underneath the sphere there’s the deep shadow that leads from mid-

dle gray into deep black (4). 

Step One: Preparation—Levels 
This photograph of London was taken on a cloudy day. The light is 

very soft and—let’s face it—quite boring. This beautiful view, taken 

from the London Eye, deserves much better lighting, so we’ll paint 

the shadows into the photograph. First, use a Levels adjustment layer 

(Layer>New Adjustment Layer>Levels) to produce a dim, shadowlike 

lighting by pushing the Output Levels highlight slider to the left. This 

reduces the brightness and the contrast of the image. Then, you 

might increase the shadow contrast a little by moving the midtones 

Input Levels slider (below the histogram) to the right. 
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IN A COMPOSED SCENE 

HOW TO CREATE

By Uli Staiger

http://kelbyone.com/magazine/issue/february-2015
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Step Two: Painting Shadow 
Of course, we don’t want the entire image to be dark, so mask the 

whole Levels adjustment layer by inverting its layer mask to black 

(press Command-I [PC: Ctrl-I]). In this scene, I decided to let the sun-

light come from the right side. That means that the shadow areas can 

only be on the parts of the buildings that look to the left. Just take 

the Brush tool (B), use a soft brush with a Hardness of 30–50%, and 

begin to paint the shadows onto the layer mask. (Note: You can find 

the Hardness setting by either clicking on the brush preview thumb-

nail in the Options Bar, or by Right-clicking in the image.)

Before you even think of building a drop shadow, you should analyze 

the position of the main light source in your picture. In the picture 

here, we have two light sources: the sky, which lights the whole 

scene without producing any hard shadows; and the sun, which is 

positioned right behind the model. That’s a good starting position 

because we can use the silhouette of the model to create the shadow. 

Step One: Creation of the Shadow 
First, we need a selection of the model’s outline. Since she’s already 

on her own layer, this is easy to get by holding the Command (PC: 

Ctrl) key and clicking on the model’s thumbnail in the Layers panel. 

We need to remove the whip from the selection, so press L to switch 

to the Lasso tool, hold down the Option (PC: Alt) key, and drag 

around the various sections of the whip to remove it from the selec-

tion. Of course, we want the shadow to be on its own layer, so click 

the Create a New Layer icon at the bottom of the Layers panel to 

create a new layer underneath the model’s layer.

Go to Edit>Fill, select 50% Gray in the Use drop-down menu, 

and click OK to fill the selection with 50% gray. Press Command-D 

(PC: Ctrl-D) to deselect. Go to Edit>Transform>Flip Vertical to flip 

the layer vertically. Then, move the shadow down with the Move 

tool (V) until the bottom of its right foot touches the bottom of the 

model’s right foot. (Note: We’ve lowered the Opacity of the Back-

ground layer in the image here so you can better see the shadow.)

Step Two: Blend Mode and Transformation 
A drop shadow like the one we just created is always translucent. 

Lowering the Opacity of the layer looks unnatural, so we keep it at 

100% and instead change the blend mode from Normal to Multiply 

at the top of the Layers panel. Considering the sun as the projection 

light source for the shadow, it needs a perspective transformation. In 

the Edit>Transform menu you’ll find the Perspective transformation. 

Click-and-drag the bottom-left corner of the bounding box to match 

roughly the perspective lines of the cobblestones and your transfor-

mation will be perfect! Press Enter to commit the transformation.

Step Three: Adaption of Perspective View 
The model’s left foot is positioned slightly behind her right foot. 

Unfortunately, this means that the foot and its shadow have a dif-

ferent level, so we have to pull the shadow toward the model’s left 

foot. This is a great task for the Puppet Warp tool, which you’ll find in 

the Edit menu. Just click on five or six spots on the shadow that you 

want to lock into position (you don’t have to click on the intersection 

of the lines), then click on the spot representing the foot and pull it 

right underneath the model’s foot. Done! Press enter to commit the 

Puppet Warp.

Step Four: Painting the Deep Shadow 
This seems to be a small detail that’s not important, but believe me, 

it’s very important: The thin line of the deep shadow where her shoes 

meet the road is necessary to nail the model to the ground. Create a 

new layer above the shadow model layer, and paint right underneath 

her shoes with a small brush set to black with a Hardness of 0% and 

an Opacity of 20%. You get an even better result if you do the same 

to the model’s shoes in a separate layer above the model’s layer. Hold 

the Option (PC: Alt) key and click on the line between these two 

layers, to add a clipping mask; otherwise, you darken not only the 

model’s shoes but the road, as well. 

  

Step Five: Softness
Still, our shadow doesn’t look very natural. There’s a physical effect 

called diffraction, which simply means that the light collides with 

the edge of an object. Looking at the shadow where it’s close to 

the object, this effect is hardly visible (1). The further away from the 

object, the more the shadow gets blurred (2). On the end of the 

shadow that represents the top edge of the object, the blur reaches 

its maximum (3). 
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Step Six:  
Creating Softness by Using the Filter Gallery 
There are two different ways of creating this kind of blur in relation to 

the distance between model and shadow. The easiest way is to use 

the Tilt-Shift filter, which you find in the Filter>Blur Gallery. If you’re 

not sure yet how much blur you want to apply, convert the model’s 

shadow layer into a smart object (Filter>Convert for Smart Filters) 

before applying the filter. Then, open the filter and move the solid 

bottom line close to the shoes and the bottom dashed line toward 

the end of the shadow. A Blur of around 20 px in the Blur Tools panel 

is perfect. Click OK in the Options Bar to apply the blur.

Step Seven:  
Creating Softness 
by Using the Lens 
Blur Filter 
If you’re using Photo-

shop CS6 or older, you 

can choose another way. 

First, switch to Quick 

Mask mode by pressing 

Q. Then, using the Gra-

dient tool (G), create a linear gradient that starts at the shoes and 

reaches all the way down to the bottom of the image. (Note: If your 

red overlay doesn’t match the one shown here, don’t worry, we’ll fix 

that in Lens Blur.) Press Q to change back to normal mode, save the 

selection as a channel (Selection>Save Selection), give the selection 

a name such as “gradient,” and click OK. Then, open the Lens Blur 

filter (Filter>Blur>Lens Blur) and make sure the channel you saved 

is selected in the Source drop-down menu (unfortunately, this filter 

doesn’t work with a smart object). Use a blur Radius between 60 

and 90. If for any reason the blur appears on the wrong end of the 

shadow, just click Invert. Click OK to apply the blur.

Step Eight:  
Color Adaption 
We’re almost there; we just have to take a final look at the color. 

The shadow we created is a projection of the model’s silhouette. 

Although not hit by any sunlight, shadows are never black, but trans-

lucent. There’s always a sur-

rounding light source: the sky 

in this case. On an overcast 

day, the shadows are almost 

colorless, but in this image, 

we have a great blue sky. Cre-

ate a new Curves adjustment 

layer (Layer>New Adjustment 

Layer>Curves) for the shadow 

layer—don’t forget the clip-

ping mask. Then, choose the 

Blue channel in the channel 

drop-down menu near the 

top of the Properties panel and lower its highlight Input level (white 

slider) to 224. Lower the Green channel to 243. That’s it. ■ 

http://kelbyone.com/marketplace/books/
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A dramatic change in brightness over a very short distance 

would be considered high frequency—think of them as bound-

aries. A subtle gradient across an entire photo would be consid-

ered low frequency—we’ll think of these as transitions. Classic 

examples of high-frequency elements are skin texture, grass in 

a field, and even digital noise. These features tend to be very 

small details, and their edges generally have a lot of contrast. 

The rate of change is high compared to the small number of 

pixels involved.

Low-frequency examples may include exposure differences in a 

view of the sky, uneven skin tones, and soft ripples in fabric. Transi-

tions tend to be soft, and changes in brightness or color are spread 

over longer distances—they take up more of the scene, and we 

think of them as large in context of the photo. The rate of change 

is considered low with respect to position. Remember that for the 

moment, frequency has to do with changes instead of repetition. 

This simple gradient shows the change from a high-frequency 

boundary at the top to a low-frequency transition at the bottom.

The first thing we need is a good working definition that lets us 

talk about frequency in a meaningful way. If you’re familiar with 

the term from other technical experience, you know it usually 

comes up in context of how often something changes within a 

given time period—cycles per second is a pretty common unit of 

measure. Photographs show a single slice of time, so we need to 

talk instead about change with respect to position in the image. 

Think about your photos as two-dimensional maps of pixels, and 

each pixel has the characteristics of location, brightness, and 

color. Frequency is a description of how much change in bright-

ness or color there is between locations. It’s essentially the con-

trast boundary between regions, no matter how large or small 

those regions are. It’s the change that’s important.

Note: Technical uses of the term frequency often involve 

repeating cycles or patterns. For our purposes, there is no need 

to go beyond the simple idea of rate of change versus position.

SCOTT VALENTINE
Photoshop Proving Ground 
 understanding frequency

H O W  T O  › ›

Making things a little more complicated is the fact that dif-

ferent frequencies typically overlap. You may have seen the 

standard graphic of two different kinds of sine waves added 

together. This illustrates how different frequencies combine in 

our images, sometimes making the task of separation seem very 

difficult. The high-frequency component (waves that are small 

and close together) changes the smooth, continuous wave of the 

low-frequency component.

This cloth is a good example of combining both high and 

low frequencies: the texture of the fabric is high, while the 

folds are low.

I built the black-and-white gradient here to show that using 

the frequency separation technique, you can target different fea-

ture sizes, even if they’re hard to see. The original gradient is at 

the top, followed by fine, medium, and coarse separations (the 

supplement to this article [see next page] includes this PSD file so 

you can see more details). Each one of these can be edited indi-

vidually to target different feature sizes. The low-frequency fea-

ture is simply the black-to-white gradient underneath the noise.

It’s All Relative
This leads me to the first of two major concepts I want you keep 

in mind while looking at frequency in your image:

Frequency is relative: As a given feature fills more or less of the 

entire image, that feature’s apparent frequency changes. In this 

picture from the Valles Grande Caldera in New Mexico (see top 

of next page), the dirt and rocks in the foreground are visually 

about the same size as the larger branches in the middle ground 

trees. Of course, in real life they’re vastly different sizes, but in 

terms of frequency in our image, they’re roughly the same. In 

the background, entire trees are about the same size as the fore-

ground rocks. Also look closely at the hard edges of shadows in 

the closest rocks. Making a frequency selection of just the tiniest 

details will pick up those edges because, to Photoshop, they’re 

very rapid transitions. Even though the actual shadows may be 

larger than the smallest rocks, the boundary will show up once 

you’ve performed a frequency separation pass.

This is important to remember because it affects how you 

approach editing. Using frequency separation, you choose blur 

settings based on the size of features you want to work with. 

In fact, many retouchers use multiple passes with this technique, 

taking the output of one pass as the input to the next pass. Con-

sider a situation where you need to deal with redness on a mod-

el’s face, but he also has freckles that you want to preserve. Being 

Frequency separation is one of the hottest topics in portrait retouching, even though the technique has been around 
for years. The idea is as simple as it is powerful: by splitting high and low frequencies into different layers, we can 
work with each frequency individually and be more precise while working more quickly. That’s pretty cool, but do 
you really know how to visualize and identify frequency in your images? After you read this article you will.
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aware of the differences will allow you to work more quickly 

without destroying important characteristics in your photo.

The next major concept is a little trickier to deal with:

Frequency can be directional: This is a weird idea at first, but check 

out this image of raw silk. There are strong vertical lines where 

some threads are much thicker. There are horizontal lines as well, 

but they’re less pronounced. The undulations in the fabric are, of 

course, low frequency, and they’re mostly vertical. The finest detail 

threads are both horizontal and vertical, and are more or less uni-

form. As an exercise, I’ve removed the heavy vertical threads and 

left the rest alone. The original is on top; the edit is on the bottom.

[KelbyOne members may download a PDF that shows the 

exact steps Scott used to remove the heavy vertical threads, 

plus two sample images at http://kelbyone.com/magazine/issue/ 

february-2015. All files are for personal use only.]

The trick here is that instead of the usual approach to frequency 

separation where you would apply a Gaussian Blur to isolate the 

low frequencies, I’ve used a Motion Blur along the direction of the 

feature I want to isolate (vertical). Gaussian Blur creates a blur in 

all directions, but Motion blur lets me choose a specific direction.

I then use the Apply Image step as normal, but go back 

to the Motion Blur layer and then blur it again using a small 

Gaussian Blur. When you blur as part of frequency separation, 

you’re defining detail size—the base image subtracted from the 

blurred image gives you those details. Doing the same thing 

with Motion Blur first means you can choose the direction of 

those details. The second blur using Gaussian is what removes 

the directional details. Note that the larger and smaller features 

are all still there. And I can in fact repeat the process to remove 

the horizontal elements.

Homework Assignment
For homework, I want you to try out some ways to visualize fre-

quency in your images. Here are some simple filters you can use 

to help you in this task. Some have options to refine the results, 

and while they’re helpful for this exercise, they aren’t directly 

applicable to frequency separation techniques. Still, they should 

give you a way to see new things in your images. (Note: If you 

don’t see the below filters in the Filter menu, go to Photoshop 

[PC: Edit]>Preferences>Plug-ins, and turn on Show All Filter Gal-

lery Groups and Names.)

• Filter>Sketch>Bas Relief

• Filter>Stylize>Find Edges

• Filter>Stylize>Emboss

I’d love to see what you come up with! Please share your experi-

ments, results, and questions at fb.com/PSInsight or right on the 

KelbyOne Facebook page. ■ 

Bas Relief

Find Edges

Emboss: 3px

Emboss: 12px
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Three-dimensional models representing architectural complexes contain the textures and geometry that are need-
ed to describe them; however, 3D models are rarely displayed in a way that would please a photographer’s trained 
eye. Here we learn to adapt our eyes for composing a 3D scene to a virtual camera lens.

Beyond Photoshop
 composing 3d scenes SCOTT ONSTOTT

Step One: Go to http://kel.by/1yw7o4a, click on the Down-

load link near the top right of the page, and select KMZ from 

SketchUp. Navigate to where the Isola-Tiberina,-Roma1.kmz file 

downloaded and open it in Photoshop. In the New dialog, spec-

ify 2000x2000 Pixels; leave the 3D Units set to Millimeters, which 

are what was used to model the structures on Rome’s tiny island; 

change the X value to 42551.56 (the Y and Z values will change 

automatically); and click OK.

Step Two: Accept the offer to switch to the 3D workspace by 

clicking Yes when prompted. In the Layers panel, double-click 

the 3D layer’s name and rename it “Tiber Island.” Click on the 

black triangle to the right of the layer’s name to collapse the 

display of its texture maps. Press V to select the Move tool, and 

in the Options Bar, make sure the Orbit the 3D Camera tool (the 

first icon in the 3D Mode section) is selected. Click-and-drag to 

orbit the model to visualize it for yourself.

Step Three: Alternately, you 

can rotate, drag, slide, and zoom 

the current view by using the corresponding 3D Mode tools in 

the Options Bar to compose an attractive view of the complex 

from the Tiber. Make the courtyard with the obelisk the focus of 

your composition, although not necessarily its center. If you want 

to match the 3D camera settings to mine, rather than winging 

it, select Current View in the 3D panel, and then set FOV (field 

of view) to 30mm lens in the Properties panel. Click the Coordi-

nates icon at the top of the Properties panel and enter each of the 

numeric values as shown here.

Step One

Step Three

sa
ik

in
di

 

Step Two
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Step Eight: The lighting is now too blue for my taste and that’s 

due to the quality of light in the panorama we used. Let’s try 

another panorama with different lighting conditions. Go to 

http://kel.by/12YBAx1, and download the 1280x199-pixel ver-

sion of the Beach of Balos and Gramvoussa (Panorama).jpg. Click 

the Map for Image Based Lighting icon next to IBL and select 

Replace Texture. Navigate to the 1280px-Beach_of_Balos_and_

Gramvoussa_(Panorama).jpg file and click Open. Much better!

Step Nine: We’re going to create a two-color gradient to simu-

late the sky. Command-click (PC: Ctrl-click) the Tiber Island layer 

thumbnail in the Layers panel to select all of the pixels in the model. 

Choose Select>Inverse and then Layer>New Fill Layer>Gradient. 

Click OK, and then in the resulting Gradient Fill dialog, click the 

Gradient thumbnail. Select the Foreground to Background preset 

(it’s the first one), double-click the left color stop below the gradi-

ent bar, enter #effeff at the bottom of the resulting Color Picker, 

and click OK to close the Color Picker. Double-click the color stop 

on the right, enter #8ab1f1 in the Color Picker, and click OK. 

Name the Gradient “Sky,” and click OK twice. 

Step Ten: Open Water.jpg. Choose Select>All and Edit>Define 

Pattern. Type “Water” in the Pattern Name dialog and click OK. 

Close Water.jpg without saving. Click the Create a New Layer 

icon at the bottom of the Layers panel. Using the Quick Selec-

tion tool (W) set to Sample All Layers in the Options Bar, paint 

over the vertical wall at the bottom of the 3D model and the 

place where the Tiber should be on the right of the composition. 

Choose Layer>New Fill Layer>Pattern. Click OK to accept the 

default name, set Scale to 200% in the Pattern Fill dialog, and 

click OK. Press V for the Move tool and drag the water surface 

down slightly. If you see a white line running through the water, 

click on the layer mask thumbnail for Pattern Fill 1 to make it 

active, switch to the Brush tool (B), press X until the Foreground 

color is white, and paint away the line.

[KelbyOne members may download the Water.jpg used in this 

tutorial at http://kelbyone.com/magazine/issue/february-2015. 

All files are for personal use only.]

Step Eleven: The water surface needs blur to match the field 

of view applied to the 3D layer. Right-click layer Pattern Fill 1 

and choose Rasterize Layer from the shortcut menu. Choose 

Filter>Blur Gallery>Tilt-Shift. Drag the bottom solid line to just 

above the top of the water’s edge. In the Blur Tools panel, set 

Blur to 7 px, and click OK in the Options Bar.

In this article you’ve learned many skills used in composing 3D 

scenes, including manipulating the virtual camera, adjusting its 

depth of field and mesh visibility, altering an infinite light’s angle, 

applying image-based lighting, and compositing a gradient sky 

and patterned foreground. ■ 
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Step Eleven

Step Nine

Step Eight

Step Ten

Step Four: Press C for the Crop tool and crop away the expanse 

of sky and river, creating a composition wider than it is tall (land-

scape proportions). Press V to select the Move tool and click on the 

unsightly railing that’s visible on top of one of the buildings. When 

you click this object, its corresponding mesh, mesh19, is high-

lighted in the 3D panel. Click mesh19’s Eye icon to toggle it off.   

 

Step Five: This low-poly 3D model will look better with a depth-

of-field effect blurring the lack of detail in the foreground. We 

want to guide the viewer’s eye to the courtyard in front of the 

Baroque church where there’s a lot of interesting detail. Scroll to 

the top of the 3D panel and select Current View. In the Proper-

ties panel, set Depth of Field to 0.8 and Distance to 0.28 in order 

to keep the courtyard in sharp focus and everything else with 

increasing amounts of blur.

Step Six: Right now the church’s façade is in shadow. Collapse 

the Model node in the 3D panel and select Infinite Light 1. Drag 

the light so that the virtual sun is overhead but slightly behind the 

viewer so that it illuminates the façade.

Step Seven: We could adjust Infinite Light 1’s color and inten-

sity but we’ll get better results by using image-based lighting (IBL) 

instead. IBL maps an image to a cylinder that wraps around the 

entire model and uses the color and luminosity of each pixel to 

represent separate infinite lights. That’s a finite, but large num-

ber or infinite lights!

The ultimate IBL would be to use a high-dynamic-range cylin-

drical panorama taken on site, but not being in Rome myself,  

I can’t easily capture that data. Instead, we’ll use a Creative Com-

mons panorama taken off the coast of Crete as a substitute. Go 

to http://kel.by/1yInMme and download the 1280x373-version 

of the Bay of Balos, Crete 002.jpg. Open the image in Photo-

shop, crop it to 1280x199, and then Save and close it.

Select Environment in the 3D panel and then in the Properties 

panel, click the Map for Image Based Lighting icon next to the IBL 

thumbnail and choose Replace Texture from the shortcut menu. 

Navigate to the 1280px-Bay_of_Balos,_Crete_002.jpg file, click 

Open, and the lighting on the 3D model immediately updates.

Step Six

Step Four

Step  Seven
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Product Reviews

Professional Photo Paper 
 Reviewed by Steve Baczewski

Fast, Reliable, and Lightweight
Review by Erik Vlietinck

 SanDisk Extreme Pro 480-GB SSD

Epson recently added two metallic resin-coated papers to their inven-

tory: Metallic Photo Paper Luster and Metallic Photo Paper Glossy. 

The glossy paper has a smooth texture with a high reflectance. 

The luster paper has a subtle textured surface, and reflectance is 

similar to Epson’s popular Premium Luster Photo Paper. Of the 

two papers, the metallic glossy appears to have slightly richer 

blacks with colors appearing more vibrant and saturated. Both 

papers have a pearl surface, slightly warm tone, and both use 

minimal Optical Brightener Additives (OBAs). Epson supplies ICC 

paper profiles for download from their website for both papers. 

I printed a standard reference target on both papers. The ref-

erence target is comprised of various skin tones, color patches, 

grayscale ramps, and assorted color and black-and-white images. 

The results are both papers have a wide color gamut, deep blacks 

(Dmax 2.3), and excellent color fidelity. Both papers display images 

with sharp, rich detail in the shadow areas. The metallic substance 

appears uniformly distributed in both papers and has a charac-

teristic that gives the paper a shimmer, adding a sense of dimen-

sionality and depth. The metallic characteristic becomes apparent 

when you hold the papers and light plays off the surface. 

On their website, Atomos lists drives they recommend for video 

recording to their Ninja, Samurai, and Shogun devices. Highest on 

that list are SanDisk Extreme Pro SSDs. With a write speed I saw 

increasing to more than 480 MB/s, I didn’t expect my Ninja Blade 

to have any problems writing to ProRes 422 HQ using the Extreme 

Pro 480-GB SSD. My tests, therefore, concentrated on sturdiness 

and frame loss.

With ordinary hard disks, camera motions are best kept to a 

strict minimum. If you have to move, you need to make move-

ments slow and smooth. Abrupt changes of direction or sudden 

motions will inevitably result in loss of frames.

Another problem is heat. Video recorders have no cooling 

system. Using a Ninja for three hours continuously makes the 

unit really hot, which is detrimental to hard disk lifespan and 

increases the risk of write errors.

None of these problems arose with the SanDisk Extreme Pro 

480 GB inside the Ninja Blade. The SanDisk had no trouble keeping 

up with even the most abrupt camera movements. It also didn’t 

become hot, only lukewarm after three hours of continuous use.

Both papers have a thickness of 10.5 mil and a weight of 

257 gsm. By comparison, Epson’s Exhibition Fiber has a more 

substantive feel with a thickness of 13 mil and a weight of 310 

gsm. Both papers lay flat without curling.

The metallic look is hard to define or compare to common 

metals like silver, gold, or bronze, but the distinct look of both 

papers is especially effective with black-and-white prints, add-

ing a luminous dimensionality that makes the image pop. The 

metallic quality is more for a specific look than general, all-pur-

pose use. Of course, the paper you use to present your images 

is highly subjective. ■

The only problem I could see is when you would be using 

a SanDisk Extreme Pro SSD with a recorder without a cradle. 

Because of the plastic enclosure, you could theoretically break 

your SSD if you’re not careful handling it; however, in practice 

the plastic housing is robust enough to withstand even rough 

handling. You can throw them around without worrying. You 

probably shouldn’t drive an SUV over them, but why would you 

want to do that?

With a throughput speed of roughly 450 MB/s even when the 

disk is almost full, SanDisk Extreme Pro SSDs are perfect replace-

ments for hard disks in any environment. ■

  Epson Metallic Photo Paper  
Luster and Glossy

Company: Epson America, Inc. Price: Varies by sheet and roll

Web: www.epson.com Rating: ◆ ◆ ◆ ◆

 Hot: Deep blacks; rich shadow detail

 Not: Loses some metallic look under glass

Company: SanDisk Corporation Price: $389.99 

Web: www.sandisk.com Rating: ◆ ◆ ◆ ◆ ◆

 Hot: Speed; reliability; weight

 Not: 

Company: DxO Labs Price: $129 

Web: www.dxo.com Rating: ◆ ◆ ◆ ◆ ◆

 Hot: New films; interface 

 Not: 

More Film Emulations and Creative Features
Review by Erik Vlietinck

Professional Image-Editing Software
 Review by Erik Vlietinck

 DxO OpticsPro 10 Elite Edition

DxO FilmPack 5 has 16 new analog film renderings, including the 

more exotic ones like Adox CHS 100 II, Bergger BRF 400 PLUS, 

and Foma Fomapan 100 Classic. The excellent Ilford Pan 100 and 

Adox Color Implosion are also included. No matter how much  

I like the new included films, I especially like the updated interface 

and creative controls.

The most appealing new feature must be FilmPack 5’s sup-

port for the RAW image format. It allows the software to 

fully exploit all of the calibrated camera data. When I opened 

a couple of photos, the app first asked me if it correctly rec-

ognised my Zeiss lens. When I clicked OK, the lens data was 

downloaded and color was immediately adjusted. Lens data 

also increases the effectiveness of DxO FilmPack’s automatic 

Color Protection processing.

The new interface shows all films in thumbnail format in the 

right panel. The Fomapan films were a revelation, as was Adox 

Silvermax 21. These are rich in contrast, with a bit of a dark, 

almost gloomy atmosphere. The others seemed more main-

stream, at least to me.

DxO has improved its flagship image-processing app once again. 

DxO OpticsPro 10 Elite has a new ClearView feature to remove haze 

and an improved Probabilistic RAW Image Enhancement (PRIME) 

denoising algorithm. DxO OpticsPro 10 also integrates with DxO 

ViewPoint if you have it on your system, giving you access to its 

distortion correction tool.

DxO ClearView is designed to automatically eliminate atmo-

spheric haze that’s visible in many landscapes and cityscapes. 

It works by analyzing the color components of each pixel and 

then locally improving contrast. The algorithm creates a sort of 

depth map of the image scene and removes the gray veil when 

necessary. Advanced users can modify the intensity of the effect 

or turn it off completely. I tried it with a photo of a city con-

taining a horizon with some buildings half hidden in smog. The 

ClearView feature worked fine but also increased contrast in the 

clouds and foreground buildings. Still, by decreasing the effect 

from its default setting of 50 to 30, I achieved a balanced look 

with less haze but still outspoken depth and less brightness loss 

in the darker areas that were closer by.

You can quickly go through all film presets, but you can adjust 

the image either with film and grain settings or from scratch. 

In both scenarios, the panel changes to creative controls, where 

you’ll find a new micro-contrast tool that brings out relief and 

details in images. The effects remained subtle and natural, and 

never got so far as to mimic faux HDR.

A new Toning tool lets you apply a color effect separately 

to highlights and shadows, bringing the simulation of historical 

photo colors within easy reach. The Blur tool has been simplified 

and offers two modes: Vignetting and Soft Focus, for creating an 

artistic blur effect that’s ideal for portraits. ■

DxO ClearView left me with mixed feelings. You don’t need to 

create complex masked areas or graduated filters to achieve the 

same effect, but I couldn’t achieve the perfection that I’m used to 

with PRIME, for example. PRIME has become faster and is slightly 

better than the original. A nice feature in the improved PRIME is 

the bigger preview panel.

Another nice feature is the integration with DxO ViewPoint 2. 

If you have a license for ViewPoint 2, you can use the ViewPoint 

features to correct for perspective, horizon, and other geometrical 

problems right in DxO OpticsPro 10. ■

 DxO FilmPack 5 Elite Edition

Company: DxO Labs Price: $199

Web: www.dxo.com Rating: ◆ ◆ ◆ ◆

 Hot: PRIME denoising; integration with ViewPoint 2.5

 Not: ClearView affects nearby objects at its default setting

www.epson.com
www.sandisk.com
www.dxo.com
www.dxo.com
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Super 16 Digital Camera
 Review by Michael Corsentino

Daylight LED Fresnels
Review by Michael Corsentino

4K Ultra High-Definition Display
 Review by Steve Baczewski

LED and Flash Diffuser 
Review by Erik Vlietinck

 Blackmagic Pocket Cinema Camera

It’s true that good things do come in small packages. I don’t think 

a better statement exists to sum up the Blackmagic Pocket Cin-

ema Camera. This tiny, dedicated cinema-quality video camera 

packs a wallop in the quality and features versus size department. 

The Pocket Cinema Camera allows you to carry the creative 

power of high-resolution 1080HD capture, a Super 16mm-sized 

sensor, and a staggering 13 stops of dynamic range, all in the 

palm of your hand. Thirteen stops of dynamic range translates 

into superior image detail and the film look Blackmagic cam-

eras are known for. Along with its support for RAW capture, the 

Pocket Cinema Camera’s dynamic range also provides a greater 

latitude for color grading and other postproduction tasks. In fact, 

the Pocket Cinema Camera shares many features with its larger 

and costlier brethren. 

A Micro Four Thirds lens mount means compatibility with a 

wide range of high-quality lenses. It’s also compatible with PL 

mount and Super 16 cine lenses via common available third-party 

adapters. The Pocket Cinema Camera’s built-in SD card recorder 

makes long recordings easy and its numerous open file formats, 

If you’re just getting started with lighting, nothing beats constant 

lights; what you see is what you get. You could easily argue the 

king of the constant light jungle is the Fresnel with its focusable 

beam (spot to flood, hard to soft), barn doors, and venerable 

history of uses in theatrical, still, and motion-picture applications. 

Italian lighting manufacturer Lupo Lux has ushered the Fresnel 

into the modern age with the introduction of their new Lupolux 

Dayled 650 and 1000. Each has a color temperature range from 

3200–5600K, is flicker-free for video use, and draws power via 

AC or 14.8 V batteries.

If you’re a fan of the glamour style of lighting popularized by 

legendary Hollywood photographer George Hurrell, then these 

are the lights for you. They also excel at noir, boudoir, beauty, you 

name it. They have all the benefits of traditional focusable Fresnel 

hot lights, but without the heat. They sport modern tech ame-

nities, such as daylight-balanced LEDs, digitally controlled dim-

mers, LCD display, and DMX capabilities (lights can be linked and 

controlled simultaneously). Additionally, they run silently, have a 

high color rending index (CRI), and they’re very efficient, requiring 

Acer’s B286HK 4K ultra high-definition display has an impres-

sive native resolution of 3840x2160 pixels, which is great news 

for graphic artists and photographers wanting to work in fine 

detail. There are, however, other considerations to think about 

before buying.

The B286HK has a 28" nonglare-coated screen supported by 

a sturdy stand that allows the display to move smoothly when 

adjusting the screen’s height, swivel, tilt, or orientation to either 

landscape or portrait mode. The large screen is perfect for simul-

taneously viewing multiple documents. It supports broad connec-

tivity with DVI, full and mini DisplayPorts, HDMI, and four USB 3 

ports. It has an onscreen manager with a six-button control panel 

on the bezel’s lower-right corner. The control panel includes five 

color screen presets and adjustments for brightness, sharpness, 

contrast, and color temperature.

Using Datacolor software and colorimeter, I measured the 

color space to be 75% of Adobe RGB 1998, well below the usual 

98%-wide color gamut used by most photography professionals. 

There are several other considerations before buying a 4K display.  

The first regards content availability and, at this point, 4K dis plays 

aren’t supported by Adobe for Lightroom or Photoshop, and there 

The Lumenator Pro can be used to complement your flash or as 

a video light. When I opened the device package, the plastic shell 

fell apart. Along the edge of one half were the LEDs, electronics, 

and battery/power interface, while the other half held the semi-

transparent reflection disc. I glued the whole thing back together 

and then tried to read the literal, Chinese-to-English translated 

instructions to charge the battery. (ColorRight should make an 

effort to include more useful battery-operation instructions, as 

improper use can be dangerous.)

The Lumenator Pro comes with Samsung LEDs, claimed by the 

company to produce the smoothest, most natural LED light avail-

able; however, based on Samsung’s press release (May 2014), the 

Lumenator’s color rendering index (CRI) is only 90 or less. With the 

dim switch in the lowest position, the LEDs became bright points. 

The dim switch itself was flimsy and unreliable. Dimming isn’t 

always flicker-free, which makes the device less suitable for video.

The Lumenator Pro’s battery is a 2800 mAh, li-ion, nonstan-

dard model. My review battery was a 3800 mAh model, so I can’t 

comment on runtime. Even dSLR video shooters will prefer stan-

dard batteries such as Bauer, Sony NP, etc.

such as ProRes 422 (HQ) and lossless compressed CinemaDNG 

12-bit RAW, are all compatible with popular NLE editing software. 

As a matter of fact, Blackmagic makes a lite version of DaVinci 

Resolve available free to anyone.

Inputs and outputs also don’t disappoint with the following 

included: mini jack mic/line audio in, micro HDMI output (for 

monitoring with camera status graphic overlay), headphone mini 

jack, LANC remote control, and a 12V DC power connection. 

Controlling the camera and settings is intuitive via the built-in 

LCD and easy-to-use menu system. ■

minimal power consumption from 50–90W depending on the 

model in use. Full disclosure: I own a bunch of these lights and  

I love them!

Tough as nails carbon-fiber construction also helps these 

lights stand up to rigors of daily studio use. All of this makes 

the Lupolux Dayled Fresnels a winning combination for lighting 

geeks everywhere. ■

has been no word as to when support will be added. On the other 

hand, games supporting 4K have lots of detail and look striking. 

Make sure your graphics card has DisplayPort connectivity and 

enough VRAM. DisplayPort connectivity is necessary to get 4K res-

olution running at 60 Hz; otherwise, it runs 4K at 30 Hz, which isn’t 

ideal for smooth movement. Finally, when working at 4K’s native 

resolution, type becomes small and if you have trouble reading 

panels in Photoshop, it gets worse. With the lack of Adobe support 

for 4K displays, scaling type in Photoshop preferences won’t work.

This is a good display but it will be better when supported by 

more content. ■

 You use a Velcro strap to mount the Lumenator onto a flash, 

but ColorRight says it’s powerful enough for studio use (an over-

statement). At its highest brightness, measured at a distance of 20", 

the Lumenator Pro spit out 420 lx at 5920K. At its lowest setting,  

I was left with 42.5 lx at 5800K.

All my findings are based on a damaged test unit that had been 

used previously for an unspecified period of time. I emailed the 

company informing them of all these issues, but never received 

a new unit. ■

 Lupolux Dayled 650 & 1000

 Acer B286HK Display 

 ColorRight Lumenator Pro

Company: Acer Price: $599.99

Web: www.acer.com Rating: ◆ ◆ ◆ ◆

 Hot: Ergonomics; contrast; angle of view

 Not: Restricted content; small color space; weak internal speakers

Company: Blackmagic Design Pty. Ltd. Price: $995

Web: www.blackmagicdesign.com Rating: ◆ ◆ ◆ ◆ ◆

 Hot: Dedicated cinema camera; compact; lightweight; RAW support

 Not: 

 ›  ›  GET THE SCOOP ON THE LATEST GEAR

Company: Lupo Lux srl Price: LL650: $1,595; LL1000: $1,995 

Web: www.lupolux.com Rating: ◆ ◆ ◆ ◆ ◆

 Hot: Build quality; dimmer; Fresnel lens; cool to the touch

 Not: Mechanism for attaching barn doors could be better

Company: ColorRight Price: $149

Web: http://colorright.com Rating: ◆ ◆ ◆ ◆ ◆

 Hot: Great concepts 

 Not: Flimsy; average CRI; low lux; nonstandard battery; no support

www.acer.com
www.blackmagicdesign.com
www.lupolux.com
http://colorright.com
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Updated to include Photoshop CC 2014 (and all of the fea-

tures added to that version up until press time), this is the most 

detailed book available on Photoshop. In addition to almost 

a thousand pages, there’s a website that includes everything 

that would have been on a CD. (Not including a physical CD 

helps keep the price down.) The website includes image files 

so you can follow along using the same photos with which 

the author works. You’ll also find dozens of additional sec-

tions and articles that didn’t fit in the print version—after you 

buy this book visit the website right away to see what’s there. 

While features were added to Photoshop after the book went 

to print, keep an eye on the author’s own website for info on 

Photoshop updates (and other photo and digital imaging infor-

mation). This book is appropriate for beginners and advanced 

Photoshop users.

Here’s another great selection from Germany by Rocky Nook 

(and another excellent translation by David Schlesinger). The 

book is mostly short explanations accompanied by several 

diverse examples. The text is concise but quite informative, and 

is typically accompanied by a number of images that vary quite 

a bit while still showing examples of the lesson. In some sec-

tions the author shows variations of a single scene, comparing 

and contrasting the advantages of one over another (or why 

they both work well). The author has chosen to use only gray-

scale images in the book, which helps keep the focus on the 

composition of the images without any distraction that could 

be caused by color or saturation. You’ll find many of the images 

inspirational and perhaps even something you may want to 

emulate in your own portfolio. (While the book’s images are 

grayscale, most of them would also be excellent color photos.)

Photographic Composition: Principles of Image DesignPhotoshop CC: The Missing Manual, 2nd Edition
By Albrecht RisslerBy Lesa Snider

          

Publisher: O’Reilly Media, Inc. Pages: 955 

Website: www.oreilly.com 

 Price: $49.99  Rating:  ◆ ◆ ◆ ◆ ◆

Publisher: Rocky Nook Pages: 185

Website: www.rockynook.com 

 Price: $39.95 Rating:  ◆ ◆ ◆ ◆ ◆

Add Light and Electrifying Effects to Your Images  
Review by Daniel M. East

Analog Effects for Digital Images
Review by Daniel M. East

 Topaz Glow

Topaz Glow is almost like Auto-Tune for music. You can take a 

decent image and modify the output to be beautiful if you make 

the effects either nearly seamless or obvious to the extremes. It 

may not be for everyone, but Topaz Labs’ Glow makes for some 

delicious eye candy. From funky to fantasy, and with lots of pre-

sets to start you on your path, Glow allows your mind’s eye to 

look beyond traditional effects.

From sketch-like looks to nearly cartoon styling, the user can 

customize the effects with a very simple (and familiar-looking) 

slider-based interface. Depending on your personal preference, 

Glow seems to offer its best results from either minimal opac-

ity or extremely intense effects. Plus, its ability to go beyond the 

traditional Photoshop effects really gets exciting as you become 

more familiar with customizing the presets. Adding the effect to 

a specific element of your image, like a guitar’s pickguard or a 

window reflection, can add a stunning focal point to your images.

Beware the temptation to go too far, though. There’s no 

wrong image for these effects, as you have excellent control over 

the blur or detail of nearly any image you choose; however, if 

Even though it has only been a brief amount of time since the 

release of Exposure 6, Alien Skin isn’t a company that releases 

service updates. Their continuing full version updates offer real 

feature changes, improvements, and performance upgrades. 

Already a longtime favorite for photographers who want to emu-

late their beloved analog film emulsions and create detailed digi-

tal effects, Exposure 7 steps up as must-have software, even if 

you’re too young to have ever used analog film.

Exposure offers high-quality analog film, lens, and bokeh emu-

lation effects in Photoshop and Lightroom, or as a stand-alone 

application. Since it requires more recent operating systems, host 

software versions, and hardware, using the desktop version may 

be your only option if you don’t meet the system requirements. 

It’s worthwhile, though, given the quality of the output.

Alien Skin has added an image browser so there’s no need for 

the open file command. It does take a second to realize this, but 

it’s easy to navigate, especially with external drives and servers. 

The new film types added include some popular favorites of both 

consumers and pros. As a former manager of professional analog 

photo labs, I can tell you that the presets are remarkably true to 

the emulsion types of the original films. The new ability to crop 

you’re creating images for clients, having some open space in 

your overall image prevents the effects from overwhelming the 

view. If you want to go beyond the old electrify effects to create 

anything from a movie poster to a business card, but have some-

thing more fluid looking in mind, try Glow from Topaz Labs. It will 

be music to your eyes. ■

and rotate your image in the software saves both time and steps 

when editing your images.

If you haven’t tried Exposure, Alien Skin offers free online 

video tutorials and a free trial version. From retro effects to 

abstract concepts and more, Alien Skin Exposure 7 goes beyond 

its origins and takes digital imaging to a place where past, pres-

ent, and future combine. For the longtime or first-time user, you 

may find yourself creating presets, or just playing with settings, 

to bring new life to your images. ■

 Exposure 7

Company: Alien Skin Software, LLC Price: $149 (Upgrade: $69)

Web: www.alienskin.com Rating: ◆ ◆ ◆ ◆

 Hot: New features; RAW support in stand-alone app; image browser

 Not:  Requires later versions of software and hardware; no longer a  
free upgrade from previous version

Company: Topaz Labs, LLC Price: $69.99

Web: www.topazlabs.com Rating: ◆ ◆ ◆ ◆

 Hot: Fun; funky; fast; ease of use

 Not: Easily overused

www.oreilly.com
www.rockynook.com
www.alienskin.com
www.topazlabs.com
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ALL IMAGES BY COLIN SMITH

In this installment, I’m going to show you really interesting 

tips. Many of the tools that you use every day have hidden and 

undocumented features. I’m going to open up some new pos-

sibilities and cool things that you probably didn’t know you could 

do with your favorite tools in Photoshop.

Motion Control
If you have ever added a Motion Blur (Filter>Blur>Motion Blur) 

and tried to set its Angle to exactly 0° or 90°, it’s like trying to put 

exactly $40 of gas into your car. You release too soon and you’re 

slightly under, then you give it a nudge and you’re slightly over. 

This can be quite frustrating at times. Sure, you could type in 

the numbers, but that takes time and effort. The tip is this: hold 

down the Shift key and the angles will now be constrained to 

15° increments. This tip also works for many tools in Photoshop 

when you’re rotating things and want to constrain them. 

Precise Vanishing Point
Vanishing Point (Filter>Vanishing Point) is a useful tool for com-

positing, painting, and cloning in a pseudo 3D space. What does 

that mean? If your photograph has perspective, you can make 

your Photoshop tools in Vanishing Point match that perspective. 

The first thing you have to do is tell Vanishing Point what surface 

you want to work on and its perspective. You do this by creating 

planes with the Create Plane tool (C). When you create a plane, 

you need to click carefully to precisely place each corner for the 

four-sided plane. Do you want to get in closer to see the corner? 

Hold down the X key and it zooms in and makes it easier for you 

to work with precision.

Change Settings Easily
For most tools in Photoshop where there’s a number field, 

you can click-and-drag on the name of the field to increase 

or decrease the value. This is known as scrubby sliders 

because you’re literally scrubbing through the settings. 

The way they work by default is fine about half the time. 

The rest of the time, don’t you wish they were slower or 

faster? That problem can easily be solved. Hold down Shift 

or Option (PC: Alt). Shift will speed up the slider 10x, while 

Option (PC: Alt) will slow it down 10x. I use this one every 

day in my workflow. 

Precise Cursor
Speaking of precision, sometimes when you’re working with the 

tools in Photoshop it’s hard to tell exactly where you’re going 

to click because the cursor might be a big circle or a weird tool 

shape. If you turn on the Caps Lock, you’ll get a crosshair for your 

cursor so you can work pixel perfect. 

Splitting Hairs
There are so many 

uses for the Blending 

Options in the Layer 

Style dialog it wouldn’t 

behoove anyone to 

try and explain them all in this paragraph. The most common 

use is to drag the black slider below Underlying Layer to let the 

shadows come through from the layer below, or move the white 

slider to let the highlights come through from below. To enter 

this mode, make the layer you’re working on active, click on the 

Add a Layer Style icon (ƒx) at the bottom of the Layers panel, and 

choose Blending Options. No matter how you choose to use this 

tool, you’ll get harsh transitions with the triangle sliders. The trick 

is to hold down the Option (PC: Alt) key to split the triangles in 

half and drag one side only, making a smoother transition. 

Show Your Limits
When making adjustments with sliders in powerful tools such 

as Levels and Curves (this also applies to all the basic exposure 

settings in Camera Raw), it’s important to keep your eye on the 

brightest and the darkest parts of the photo. This is to prevent 

losing detail. Some people keep their eye on the histogram, and 

that’s a good thing to do. If you hold down the Option (PC: 

Alt) key while dragging the sliders, you’ll get a visual indication 

when the highlights and shadows are past their limits (known as 

clipping). This gives you a good idea how far to move a slider if 

you’re going for maximum contrast while still keeping the details 

in an image. 

New Document with Options
To create new layers quickly, click the Create a New Layer icon at 

the bottom of the Layers panel. You can also use the keyboard 

shortcut Command-Option-Shift-N (PC: Ctrl-Alt-Shift-N). This is 

great most of the time. There are times when you need a layer 

that’s filled with a neutral color for more control over different 

special effects (dodge and burn, lens flares, etc.). The quickest 

way to do this is to hold down Option (PC: Alt) as you click the 

Create a New Layer icon. When you do this, a dialog will appear 

with the option to choose different blend modes. Some of the 

blend modes allow you to fill with a neutral color, either black, 

white, or 50% gray.

Clouds with Contrast
When you want to make clouds, which don’t really look like real 

clouds but do form the basis of many textures, the way to do it is 

Filter>Render>Clouds. Press Command-F (PC: Ctrl-F) to change 

the clouds until you see some you like. If, however, you want to 

make clouds that are denser and have more contrast, hold down 

the Option (PC: Alt) key as you apply the clouds and you’ll now 

see significantly more contrast in the clouds. 

Controlling Blur Edges
When you’re creating nondestructive blurs using the Blur Gallery 

(Filter>Blur Gallery), there’s a hidden secret in the Iris Blur (the 

one that creates a Lensbaby-type effect). If you hover your cursor 

inside the circle in the Iris Blur, you’ll see four dots. You can drag 

the dots toward the outer circle to make a harder edge between 

the blurred and nonblurred portions of the image. If you drag 

inward, the falloff will be gentler, making a softer edge. Notice 

all four dots move together, no matter which one you drag. You 

can move them individually and create a nonround falloff. To do 

this, hold down our good friend the Option (PC: Alt) key. Now, 

you can drag each dot independently from the others.

More Eyedropper Options
The Eyedropper tool (I) is a useful tool for grabbing colors from 

an image. With the Eyedropper, you click on the color that you 

want to use, and your Foreground color changes to that new 

color. What if you want to sample a different color and keep 

the current one? You can sample a color and change the Back-

ground to that new color instead of the Foreground. All you have 

to do is, you guessed it, hold down Option (PC: Alt) and click on 

a color and it becomes the Background color. To switch between 

the two colors, press the X key. ■
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To: William
From: KelbyOne Help Desk

The Libraries panel (Window>Libraries) enables you to 

store assets that can be used over and over again. You 

can also share assets between programs (Photoshop, 

Illustrator, and some of Adobe’s mobile apps).

Assets can be images, type styles, color swatches, 

brushes, and layer styles. When you create a new 

library or add an asset to a library, it’s automatically 

synced through the Creative Cloud to all library-capable  

programs and apps. (If you’re not connected to the 

Internet at the time, an exclamation point appears on 

the Creative Cloud logo. When you next connect, the 

Creative Cloud Manager will automatically update 

your libraries.) The Libraries panel is a “smart panel”—

it will display only the assets in the selected library that 

can be used in that program. When in Illustrator, for 

example, the Libraries panel will not display Photoshop 

layer styles.

The Libraries panel starts with an empty library 

named My Library. That library is great for items that 

you need for multiple projects. You can create indi-

vidual libraries for each of your projects. Click on 

the Libraries drop-down menu (where you originally 

see My Library), select Create New Library, name the 

library, and click the Create button. The new library is 

added to the top of the list. You can have an unlimited 

number of libraries, so be specific when naming new 

libraries for specific projects. Keep in mind that each 

library can contain up to 1,000 items, so for complex 

projects you may need multiple libraries.

Libraries can be renamed and deleted through the 

Libraries panel’s flyout menu. You can also elect to 

From The Help Desk 
 

›  ›

The KelbyOne Member  
 HELP DESKS 

Are you taking advantage of the Help Desks at the KelbyOne member website? This is the place where you can get all of your 

Photoshop and Lightroom questions answered either by other KelbyOne members or by our Help Desk experts. Not only that, you 

can get photo and computer gear help and advice, as well. What are you waiting for? Visit the Community section on the 

KelbyOne member site today! ■

show the assets in a library sorted by date created or 

alphabetically. And note the two icons directly to the 

right of the Libraries drop-down menu. The first (the 

default) enables you to view each asset in the library 

as an icon; the second icon shows all assets in a list 

format. A list may be helpful if you have a number of 

type styles, since it displays more info about the type 

style. But if you have lots of graphic assets in a library, 

you’ll get a better look at them using the icon option.

To add an image asset to the active library, simply 

click on it in the image window with the Move tool (V) 

and drag it to the Libraries panel. You can also activate 

the layer in the Layers panel that contains the graphic 

and then click the Add Graphic icon in the lower-left 

corner of the Libraries panel. To add a color swatch 

to the active library, click on something of that color 

in the image window using the Eyedropper tool (I), 

then click the fourth icon to the lower-left, Add Fore-

ground Color, and the swatch is added to the library. 

Text styles and layer styles are added in a similar man-

ner: activate a layer in the Layers panel that uses the 

style, then click the appropriate icon at the bottom of 

the panel to add that style as an asset. Double-click an 

asset name in the Libraries panel to rename it.

Six of Adobe’s apps can work with your libraries. 

You can use Photoshop Sketch (to create brushes), 

Illustrator Draw (images and shapes), Illustrator 

Line (images), Shape CC (vector shapes), Color CC 

(swatches, color themes), and Brush CC (brushes). You 

can also get free high-quality assets through the Cre-

ative Cloud Manager.    

What is the Libraries panel and how do I use it?—William
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